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Chapter Overview
• Introduction to the AlphaImager Systems and AlphaView Software

• About This Manual

• Customer Service and Technical Support

• AlphaImager System Setup
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Introduction to the AlphaImager Systems and AlphaView Software
The AlphaImager systems are designed to meet the requirements of the most demanding fluorescent and col-
orimetric applications. These systems integrate the latest developments in camera and lens technology for 
imaging with a wide dynamic range and fast image acquisition speeds.

The systems are controlled by easy-to-use and intuitive AlphaView® software which performs image analysis 
and archiving and can also prepare images for desktop publishing. 

AlphaView software includes image optimization tools that adjust contrast automatically or manually. Convert-
ing the image from positive to negative, using digital filters, applying a false color map, or other such tech-
niques can be used to clarify hard-to-see portions of the image. Notes, labels, arrows, lines, and other drawing 
tools can be recorded directly onto the image using AlphaView software’s annotation functions. Annotations 
are superimposed on the image upon hard copy printing and can either be saved as a template file or as part 
of the image. All AlphaView features are accessible via convenient on-screen buttons and menus in an intui-
tive, mouse-controlled interface.

AlphaView software also includes a broad array of analysis tools, including molecular weight calculation, Rf 
determination, lane profile, band analysis, quantitative PCR, microtiter plate reading, object distance 
measuring, gel scoring, and automatic colony counting.

AlphaImager systems include all necessary hardware and software for image capture, enhancement, and anal-
ysis. AlphaView software does not require a dedicated computer system and can operate simultaneously with 
other office-related software, such as word processing programs, spreadsheets, and desktop publishing soft-
ware.

Images can be printed using a 256-level gray scale thermal printer or any printer with a Windows® driver. The 
low-cost, high-quality prints are ideal for lab notebook records or publication. 

The “AlphaView System Quick Guide” on page 29 provides a condensed instruction sheet that acts as a quick 
reference guide for users already familiar with the software. Keeping copies of the appropriate instruction 
sheet(s) near the system for easy reference is highly recommended.

Mouse Functions

The system comes packaged with a two-button mouse. The left button activates functions and makes selec-
tions when using the software. In some cases, the right mouse button can recall or reactivate the function that 
was most recently assigned to the left mouse button. 

Starting AlphaView Software

To start AlphaView software, double-click the AlphaView software icon on the Windows desktop.
AlphaImager HP, EP and EC User Guide
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About This Manual
This manual uses different fonts to indicate certain conditions:

• Bold text indicates the name of a button, a menu, or a function found in a menu.

• Courier text indicates an entry that is typed.

• Letters or words found between < > refer to keys on the keyboard.

• NOTE indicates key points and useful hints.

• CAUTION and !WARNING! statements indicate actions that may either harm the system or user, 
or affect the data quality.

• Icons or buttons to be pushed are placed next to their respective descriptions in the text.

Customer Service and Technical Support 
The Cell Biosciences staff is available to respond to any questions or comments about the software. For ques-
tions, new software feature ideas, or general feedback, use the following contact methods:

Telephone
(408) 510-5500 
(888) 607-9692 (toll free) 

Fax
(408) 510-5599

E-mail
support@cellbiosciences.com

Web
www.cellbiosciences.com

Address
Cell Biosciences, Inc. 
3040 Oakmead Village Drive 
Santa Clara, CA 95051
USA

AlphaImager System Setup
Please refer to Appendix D, “Hardware Installation for AlphaImager HP and EP“ or Appendix E, “Hardware 
Installation for AlphaImager EC“ for complete instructions on system installation. 
AlphaImager HP, EP and EC User Guide
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Chapter 2:

Getting Started—Basic Imaging 
Functions

Chapter Overview
• Basic Imaging Functions

• Automatic Image Capture (AIC) Software–Optional

• AlphaView System Quick Guide

• Contrast Adjustments

• Imaging Tools
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Basic Imaging Functions
Power up the system computer and click on the AlphaView icon on the desktop to open AlphaView soft-
ware. 

Figure 2-1: AlphaView Screen—Displaying the Image Area and Display Controls

AlphaView software has four main control areas:

• Acquire for image acquisition

• Contrast Adjustments for image adjustment

• Enhancement Tools for image enhancement

• Analysis Tools for image analysis

Acquiring an Image Using the Navigator 

Clicking the Navigator toolbar icon will guide the user through commonly used applications. In this 
example procedure, the “Ethidium Bromide” application is demonstrated.
AlphaImager HP, EP and EC User Guide
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Figure 2-2:  AlphaNavigator—Selecting the Yes Option

Selecting the “Yes, …” option displays the following dialog box:

Figure 2-3: Selecting the Gel Option

Selecting Gel displays the following screen:
AlphaImager HP, EP and EC User Guide
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Figure 2-4: Selecting the Nucleic Acid Option

Selecting Nucleic Acid displays the following screen:

Figure 2-5: Selecting the Ethidium Bromide Stain Option

Choosing Ethidium Bromide will select the proper light source and filter needed. The acquisition screen in the 
preview mode is displayed with the Auto Expose option selected.
AlphaImager HP, EP and EC User Guide
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Figure 2-6: Previewing Your Image

AlphaNavigator displays navigation notes. Click on the Advanced button to access more acquisition controls, 
or click Next to acquire. If the Advanced button is selected:
AlphaImager HP, EP and EC User Guide
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Figure 2-7: Advanced Mode—Accessing Acquisition Controls

The user can modify any control, click Next to acquire, or Back to return to the Preview Mode.

If Next is selected the following screens are displayed: 

Figure 2-8:  Image Acquisition Confirmation Prompts
AlphaImager HP, EP and EC User Guide



Basic Imaging Functions page 11
Selecting the Yes option and clicking Next will produce a saved protocol dialog box. The protocol will be 
added to the list of existing protocols.

Selecting the No option and clicking Next will generate the save image dialog box:

Selecting the Yes option and the clicking the Finish button will generate the save image dialog box and exit the 
Navigator. Selecting the No option, will close the Navigator.

The next time the Navigator is run, the user can run the saved protocol:

Figure 2-9: Running the Saved Protocol

Selecting the No option, the following screen is generated with the last saved protocol selected.

Figure 2-10:  Selecting the Saved Protocol

The user can browse for other saved protocols by clicking on the down arrow. A list of existing protocols will 
be displayed; see Figure 2-11.
AlphaImager HP, EP and EC User Guide
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Figure 2-11: Selecting "My Eth. Boromide" Saved Protocol

Selecting the protocol will go to the preview screen for the user to verify or acquire the setting.

Acquiring an Image Using the Acquire Button

In the Tool Bar, click the Camera Acquire icon, which launches the Camera Setup and Preview 
window; see Figure 2-12.
AlphaImager HP, EP and EC User Guide
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Figure 2-12: Camera Setup and Preview Window

This window provides camera exposure control, lighting/filter wheel position control, contrast display options, 
and cabinet door status. 

NOTE: Cabinet lighting/filter wheel position controls are only available with the AlphaImager HP.

Focus Control Mode

This window opens in Focus control mode (blue button). Focus control mode provides near-real time 
readout for easy sample positioning and optics adjustments. While in focus, select the lighting, filter, and 
binning options appropriate for your sample. You can then focus on your sample, select an aperture setting, 
and focus on your image.

NOTE: While in Focus control mode, we recommend clicking the Auto Expose check box to allow the 
software determine the optimal length of time for your image acquisition. 
AlphaImager HP, EP and EC User Guide
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Preview

Clicking the Preview box allows you to preview what your final image would look like, while still allowing you 
to make small adjustments to the options you select in focus. 

Acquire

Select Acquire to capture your final image. You will then be able to annotate, save, print or analyze your 
image. 

Motorized Optics Control 

NOTE: The motorized optics system is a standard for AlphaImager HP and EP, and is option for the 
AlphaImager EC. 

The motorized optics system is controlled through the AlphaView software. Aperture, focus, and zoom can 
be user-customized through the fields and buttons on the software acquisition window.

Figure 2-13: Motorized Optics Control

The up and down arrow buttons change the values in increments based on the specific lens in use for 
aperture, focus, and zoom. Values can also be changed by directly entering a new number in the value’s 
respective field or by selecting a value from the drop-down menu (down arrow button). 

Auto Expose

The AlphaView features an Auto Expose function for ease of use. The Camera Setup and Preview window 
includes a check box to activate the Auto Expose function, as well as a button labeled Auto Expose Setup to 
configure the function.
AlphaImager HP, EP and EC User Guide
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Figure 2-14: Auto Expose

Figure 2-15: Auto Expose Compensation Settings

Clicking the Auto Expose Setup button launches the Auto Exposure Compensation Setting window. This 
window offers four options:

• Normal Exposure for image saturation. This setting is ideal for normal Colorimetric and Fluorescent 
imaging.

• Under exposure for Chemiluminescence (not recommended for AlphaImagers)

• Over exposure for faint band detection.

• Custom exposure compensation. This setting allows the user to define the Exposure Value (EV). The 
left set of up/down arrow buttons change the EV value by whole unit intervals while the right set of 
up/down arrow buttons change the EV value by 1/8-unit intervals.
AlphaImager HP, EP and EC User Guide
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Auto Exposure works in both Expose Preview and Acquire Image modes. The AlphaView software calculates 
the correct exposure time for the current situation. In Expose Preview mode, a status bar appears above the 
Auto Expose interface. In Acquire Image mode, a status window featuring a colored Auto Expose status bar 
for image acquisition appears. The status bar indicates the current status of the calculation. The status bar 
changes from red to yellow to blue to green to indicate progress. When it reaches green, the AlphaView soft-
ware has calculated the correct exposure time. For exposure time calculations with saturated pixels in the 
image area, the status bar changes to pink to indicate the issue. 

In Acquire Image mode, a green status bar indicates that the image is acquired. After achieving a green status, 
the new image loads and the Camera Setup and Preview window closes. In Expose Preview mode, the 
system continues to repeatedly expose using the calculated exposure time until a different mode is selected. 

Switching from Expose Preview mode to Acquire Image mode does not reset the calculation. If the system 
changes from Expose Preview mode to Acquire Image mode after calculating the correct exposure time in 
Expose Preview mode, images are acquired using the last calculated exposure time. 

The Exposure Value (EV) unit is the same as used in film photography (also called a “stop”). +1 EV will double 
the exposure time while –1 EV with halve the exposure time. The general exposure time using EV is found by 
the following formula:

(EVCompensatedTime) = Time*2EV

Where Time is the typical exposure time for the sample under test to reach full exposure as determined by 
the auto exposure tool.

Setting Exposure Time Without Auto Expose

Once the sample is positioned and the lens is properly focused, perform the following steps:

1. Close the MultiImage light cabinet door and check to ensure that the appropriate illumination source is 
turned on. In addition, check to ensure that the cabinet door indicator in the Cabinet Control software 
interface indicates Closed. 

2. Uncheck the Auto Expose option. 

3. Click the green Expose Preview button and select the desired exposure time in to configure the system 
for the desired image intensity quality. Individual adjustments for milliseconds, seconds, minutes, and hours 
are available. The following list describes ideal exposure settings for different applications:

• For most white-light applications, using a 50 ms exposure is sufficient. Final aperture adjustments 
can be made to optimize the image quality. 

• For UV fluorescence applications, using an exposure range between 8 ms and 4 seconds is 
sufficient. The aperture should be completely open when performing any adjustments. Selection 
Show Saturation is recommended for these applications.
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• For low-light applications, such as chemiluminescence, a longer exposure time may be appropriate. 
In these cases, push the red Acquire Image button to directly acquire the image upon setting the 
desired exposure time. If a good exposure time is unknown, an alternative method is to utilize the 
Auto Expose feature configured to super sensitivity. Auto Expose image generation—with signal 
intensity showing—generally completes in less than three minutes. After Auto Expose image 
generation, a different sensitivity (binning) mode can be selected to generate a better resolution 
image. For further images, the software automatically calculates the new exposure time.

NOTE: When the system switches to Expose Preview mode, the image may flash or change brightness due 
to camera photon collection from the image over a longer period of time prior to sending the image to the 
computer’s display readout.

Light Source and Filter Controls

NOTE: This section describes the light source and filter controls used with the AlphaImager HP and systems 
equipped with the DE500 cabinet.

The mechanical controls on the cabinet and the AlphaView software’s virtual cabinet control interface 
(labeled as Cabinet Controls) are linked and provide near-real time synchronization and updating of light 
source and filter selection. Selecting a desired option via the software interface produces the same result as 
using the physical controls on the cabinet. 

NOTE: A slight delay occurs upon pressing the button until the light source is fully activated. 

Standard lighting choices include:

• Transillumination White: For protein gels, autorads, film, plates, and flasks

• Transillumination UV: For fluorescent gels such EtBr, SYPRO Red, SYBR Safe, etc.

• Reflective White: For colorimetric blots and membranes

• Reflective UV (optional): For SYBR green, TLC plates, and Chemifluorescence

• ChromaLight (optional): For GFP, Fluorescein, and SYBR green

Filters can be selected to correspond with the sample staining. Filter options include:

• Filter Position #1: No filter

• Filter Position #2: Orange filter (590/55 nm)

• Filter Position #3: Green filter (537/40 nm)
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• Filter Position #4: Red filter (620/40 nm)

• Filter Position #5 Blue filter (460/40 nm)

NOTE 1: Each filter has an approximate bandwidth of +/- 40 nm to allow for use with other fluorescence 
stains as they are developed. For custom applications, please contact Cell Biosciences directly to discuss 
custom filter design for specific applications.

NOTE 2: If exposure time is less than 100 ms, yet signal is strong, close the aperture by stops.

Gray Scale Optimization for Saturation and Contrast Displays

Figure 2-16 illustrates the check boxes available for modifying the displayed image.

Figure 2-16: Modifying the Displayed Image

Any images set for analysis must not be over-exposed (too light) or under-exposed (too dark) for maximum 
clarity. Using the Show Saturation option displays the image areas assigned to each end of the gray scale 
spectrum. After inspecting the image’s saturation, the imaging controls can be adjusted accordingly to 
optimize the image.

The Show Saturation option allows the user to access the Saturation Palette during image acquisition. The 
Saturation Palette is a modified gray scale palette in which green replaces black (gray level 0), and red replaces 
white (gray level 255, 4,095, or 65,535). With this palette, the image’s over- and under-exposed areas appear 
as green or red, while areas within the linear range of the CCD chip appear in gray scale. 

During image acquisition, it is critical to note the image’s regions that appear red or green. The exposure time 
and the camera aperture can be adjusted to minimize the amount of red and green in the image area. 
Eliminating red and green in the actual sample area is especially critical for images that will be quantified. The 
saturation view can be turned off by unchecking Show Saturation once the red and green areas have been 
minimized and/or eliminated 

The other three selections (Chemi Display, Auto Contrast, and Reverse) act as visualization tools designed to 
enhance contrast and provide flexibility image viewing. The Auto Contrast option displays the image with 
automatic black, white, and gamma adjustments according to the image histogram information (black/white 
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levels). Reverse shows the sample as a negative by switching the black and white values. The Chemi Display 
option utilizes both auto contrast and reverse functions, as well as providing gamma adjustments, and is 
intended for use with chemiluminescent samples. 

NOTE: These options are also available in the Movie Mode. 

NOTE: These Contrast Display options are only visualization tools and do not change any image data 
acquired by the CCD camera.

Saving Images

Once a satisfactory image has been captured, it should be saved as an original file for safe archiving. Click 
File > Save As or click the Save or Save As icons.

Movie Mode

If kinetic, multiplex, color, or chemiluminescence experiments require the system to automatically capture 
several images at preset exposure times, preset time delay between images, preset lighting sources, or preset 
filter choices, then the AlphaView Movie Mode should be used. Clicking the MOVIE box in the Tool Box’s 
Enhancement Tools tab launches the Movie Mode controls. Movie Mode setup is also accessible in the 
Camera Setup and Preview window. To launch the setup screen, click the Movie Mode button in the Camera 
Setup and Preview window. 
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Figure 2-17: Movie Mode Setup

The Total Frames field sets the total number of individual frames in the movie. Each movie can capture a 
maximum of 50 frames (images) and a minimum of one frame. 

The Frame field selects the active frame currently being used for condition customization. For example, if the 
movie uses three images, selecting Frame 1 allows for lighting and filter setup of the movie’s first frame; 
selecting Frame 2 allows for setup of the movie’s second frame. All frames can be adjusted manually using this 
technique, or specific lighting conditions can be copied to the next frame using the Copy To Next button. 
Copy To Next copies all settings from the previous frame to the current frame. The Copy to End button cop-
ies current frame setting to the entire frame set.

For chemiluminescence imaging, all lighting is typically shut off and the filter wheel is positioned for the 
chemiluminescence position across all frames. In these situations, the exposure time is the only variable that 
changes from frame to frame. The Copy To Next button is a useful tool that optimizes setup time.

The Delay field configures a predetermined delay between captured imaged for kinetic experiments. The 
default Delay is set for the shortest possible delay (19 ms), but can be configured up to 50 minutes between 
images. 
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Once the movie setup is properly configured, click the Go button to begin the movie process. The system 
begins processing image acquisitions for each frame. When completed, the movie setup box disappears and 
the Toolbox window automatically configures to the Movie tools. This allows for movie playback, saving, load-
ing, or new movie recording.

The movie display buttons offer the following functionality:

Saving an Individual Image from a Movie

After you load, play, and stop a movie at the desired image, it is possible to save the individual image seen on 
the screen. Use the SAVE AS button located on the tool bar to save the image in the desired location and file 
format on the local or network drive

REC Launches the Camera Setup and Preview window configured to Movie Mode.

PLAY Displays the movie in a continuous loop.

STOP Stops the movie at the current frame display.

PAUSE Pauses movie playback at a user defined image.

REW (rewind) Rewinds the movie to the first image.

REV (reverse) Plays the movie in a continuous loop in reverse.

FWD (forward) Forwards the movie to the last image.

DEL (delete) Deletes the movie on the display.

NOTE: This function does not delete movies saved to the hard drive.

LOAD Loads a previously saved movie.

NOTE: This function does not load individual images previously captured in nor-
mal capture mode.

SAVE Saves a movie of images.
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Saving a Partially Acquired Movie
It is possible to stop the movie in the middle of acquiring frames, the user can exit the movie mode to save 
the acquired frames only.

Figure 2-18: Saving a Partially Acquired Movie

Option 1: Go to continue movie.

Option 2: Close Window to view and/or save acquired frames.

Save/Load Setup Acquisition
Individual movie parameters can be saved for future use. The Save Setup and Load Setup buttons save and 
load all Movie Mode setup parameters. This data is saved in files using the MVF format.

Figure 2-19: Movie Mode: Load/Save Setup
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Frame Stacking
The Movie Mode configuration of the Camera Setup and Preview window provides an option for stacking 
frames. If this selection is used during image acquisition, Stack Frames uses previous exposure information to 
sequentially add images to one another. Normal Sequence does not perform this addition. 

NOTE: Stacking frames increases the noise level in acquired images. 

Sample Case
Capture 5 frames at 1-5 sec exposure for total time exposure time of 15 sec

Display after summation of following frames:

Frame 1 = Image (1 sec exp time)

Frame 2 = Frame1 + Image (2 sec exp time)

Frame 3 = Frame2 + Image (3 sec exp time)

Frame 4 = Frame3 + Image (4 sec exp time)

Frame 5 = Frame4 + Image (5 sec exp time)

Automatic Image Capture (AIC) Software–Optional
For molecular biology researchers engaged in high throughput and particularly high volume work involving 
repetitive assays, Automatic Image Capture software is available. This system automatically adjusts lens focus, 
filter settings (for fluorescent imaging), light settings and exposure for perfect images. All of this with just one 
click--making the acquisition of images faster and more convenient than standard imaging software. 

NOTE: AIC requires motorized zoom optics. 

Auto Focus

The AIC software features auto focus capabilities. The Camera Setup and Preview window has two auto 
focus interfaces. The Preview Auto Focus button (see Figure 2-20) immediately utilizes the auto focus func-
tion with the updated image displayed in the image preview. Checking the Auto Focus checkbox causes the 
system to perform auto focus during the acquisition process.
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Figure 2-20: Auto Focus

Tips for Successful Auto Focus Operation

The Auto Focus operation is not guaranteed to succeed every time, but some minor considerations will 
greatly increase the success rate. A general rule is if you can manually focus on the sample then auto-focus can 
be made to work.

• For smaller targets/samples, adjust the lens’ zoom setting or use the ZoomROI tool to allow the tar-
get/sample to fill the field of view. This is especially helpful when using white lights with the target/sam-
ple on the UV transilluminator (very shiny/reflective surface).

• For thick samples, close the aperture 2 stops (e.g. from F2.8 to 4).

Auto Focus will almost certainly fail under the following conditions:

• Target/sample is not flat (inclined or stair step) greater than 1 part in 50. Manually focus on the feature 
of interest then close the aperture until the entire feature of interest is in focus (do not attempt auto-
focus).
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• Target/sample is over exposed at Normal/High sensitivity 8 millisecond exposure with lens aperture 
fully open (with reflective white light illumination for chemi samples). Reduce the signal level by using 
an emission filter or manually focus and do not attempt auto focus.

• Target/sample that has a carrier/tray with writing or other textured finish at a level different than the 
primary sample plane (such as a precast gel in a carrier). Manually focus on the features of interest or 
close the aperture by 3 stops (e.g. F2.8 to F5.6) or use zoom (or Zoom ROI) to exclude the carrier 
surfaces.

Users are encouraged to utilize the auto focus feature when ever possible. The Preview Auto Focus function 
is intended to be a tool to verify if auto focus will meet your expectations for your sample. If the Preview 
Auto Focus function is used just prior to saving a protocol, Auto Focus will be selected for your protocol, and 
when you save your protocol this message will appear : “Auto focusing will be turned ON for this protocol.”
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Designing a User Protocol

To utilize the single click feature of Automatic Image Capture, a protocol specific to your sample must 
be defined and saved. Click the Acquire button to reach the Camera Setup and Preview Window. 

All acquisition parameters that can be set by the user are available in the Camera Setup and Preview window 
and can be saved as a user protocol. Below is an example of the design of a protocol for imaging DNA gels 
stained with Ethidium Bromide. 

Figure 2-21:  Example of the Protocol Design for Imaging DNA Gels Stained with Ethidium Bromide

Next, click the Load/Save Protocol button to store your customized protocol. 

The Save/Load Acquisition Protocol dialog box appears, allowing to you save and name your protocol.
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Figure 2-22: Save/Load Acquisition Protocol

This dialog box is also useful for loading a previously saved protocol to make small modifications, or delete 
existing protocols. 

All settings and selections visible and accessed in the Camera Setup and Preview window are saved in this 
protocol. These settings include SuperOD, ZoomROI, lens settings (aperture, zoom and focus), exposure 
time (including auto exposure setup settings), sensitivity selection, display settings, cabinet lights and filter 
wheel position.

Auto Image Capture (AIC)

User-customized protocols can be recalled for single click image capture using the AlphaView software’s Auto 
Image Capture feature. First, load the protocol of interest by clicking on the drop down menu from the Auto 
Image Capture icon.

Figure 2-23: Auto Image Capture (AIC)

Then, once the protocol is selected, click the Auto Image Capture button to begin the acquisition process. 
Once the AIC process is initiated, a pop-up window, labeled Acquiring protocol, is displayed to indicate the 
status of the acquisition process. This progress window shows the current operation status and has some 
animations to indicate progress. The status messages towards the bottom of the window displays the specific 
operation and relevant parameters used during the process.
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The LIGHTS section displays different simulated LEDs repeating left to right to indicate the status of the light 
source and filter selection as dictated by the protocol. The CAMERA section displays the current status of the 
image as the target is being focused as dictated by the protocol. The ACQUISITION section displays the 
current status of the exposure time as dictated by the protocol.

Figure 2-24: AIC Status Window

NOTE: The images displayed in the Acquiring Protocol windows are animations to display status and do not 
reflect upon the image being acquired.

When the AlphaView system computer is powered up, you can click on the AlphaView icon to automatically 
open the AlphaView software. The following screen appears:
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Figure 2-25: AlphaView Screen—Displaying the Image Area and Display Controls

AlphaView System Quick Guide
1. Power on the system: 

a. Turn on the computer, monitor, and optional printer.

b. After the computer has finished loading the Windows desktop, turn on the power to the cabinet. 

c. The AlphaView software is activated by double clicking on the AlphaView icon.   

2. Positioning and focusing on the sample: 

a. In the Tool Bar, select the Acquire icon to activate the image acquisition software features. 

b. In the Camera Setup and Preview window, click the Focus button.

c. Open the door to the cabinet and position your sample on the preferred illumination source. 
Fluorescence samples that require epi or transillumination of UV energy should be placed on the 
purple UV filter glass. For colorimetric samples such as protein gels, films, or blots, use the fold-down 
white light table for your sample. For chemiluminescence use the fold-down white light table, or the 
adjustable tray if used in conjunction with the fast lens.
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d. Open the aperture on the camera lens all the way open to the smallest number by either pressing the 
up and down arrow keys, entering in a value and pressing the tab key. or selecting the preset 
parameters from the drop-down menu.

e. With the door still open to allow light to enter into the cabinet, use the monitor’s real-time readout 
display to position and focus your sample in the middle of the preview image.

f. Focus on the object by either pressing the up and down arrow keys, entering in a value and pressing 
the tab key or selecting the preset parameters from the drop-down menu. For fluorescence and che-
miluminescence, the door to the cabinet can be used to adjust the amount of light that enters into 
the cabinet if there is too much light to obtain a good focus setting. Do not adjust the aperture to do 
this. For colorimetric samples, it is necessary to decrease the aperture to acquire the image.

NOTE: Business cards and other pieces of paper with small text often are the easiest objects to obtain 
optimal focus settings with.

g. Adjust the zoom setting by either pressing the up and down arrow keys, entering in a value and 
pressing the tab key, or selecting the preset parameters from the drop-down menu so that the area of 
interest on the sample takes up the entire image size on the screen. 

3. Capturing a bright sample like fluorescently labeled gels, colorimetric samples and film:

a. Close the cabinet door.

b. Choose the appropriate optical filter for your sample type:

Position #1 for colorimetric gels and film (no filter)

Position #2 for Ethidium Bromide gels and some colorimetric gels

Positions #3-5 for other fluorescently labeled gels (optional filters)

c. Turn on the illumination source (UV or white light) using the touch panel or virtual software controls.

d. Select the green Expose Preview button.   

e. Check Show Saturation.

f. Check Auto Expose. 

g. Select the Normal/Ultra resolution setting. 

h. Once the image in expose preview does not contain any saturation (red false color palette for white 
bands, green for dark bands) click Acquire Image. The exposure bar will turn green when this is 
complete. If the exposure bar is pink in color, saturation is still present in the image. For extremely 
bright images, particularly in white light applications, it may be necessary to reduce the aperture 
setting until the saturation is removed from the image.

4. Capturing a low light image (like chemiluminescence)
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a. Close the cabinet door (there should not be any lights on in the cabinet).

b. Choose Position #1 in the filter wheel for no filter.

c. Select the green Expose Preview button.   

d. Check Show Saturation.

e. Check Chemi Display.

f. Check Auto Expose.

g. Select the Super Speed resolution setting.

h. Wait for the exposure bar to indicate that the proper exposure time has been found and that there is 
no saturation in the image - the exposure bar will turn green when this is complete. If the exposure 
bar is pink in color, saturation is still present in the image. 

i. Select Medium/High or Normal/Ultra resolution and uncheck Auto Expose.

j. Click Acquire Image.

NOTE: The exposure time will vary depending on which resolution setting is selected in step 4.h. If the 
exposure time calculated by the auto expose setting is too long, it is possible to use the Fast/Low or High/
Medium setting instead. Alternatively, if the exposure time is short enough, Normal/High may be selected 
for a full resolution (4 million pixels) chemiluminescent image. 
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5. Save the original image:

a. Select Save Image in the File menu or click on the Save or Save As icon in the Tool Bar.

b. Enter a file name and select the directory to which it should be saved (the directory path should be 
less than 100 characters).

c. Specify the file format (TIF, BMP, PCX, MAC, color TGA).

d. Click OK to save the file.

6. Enhance the display (optional):

a. Adjust the black, white and gamma levels by moving the slider bars at the right of the image in the 
Contrast Adjust window, or select Auto Contrast.

b. Apply the digital filters found in the Tool Box under the Enhancement and Filters (to stop a filter, hit 
any key on the keyboard; to reverse the effects of a filter, click Undo).

c. Add text, boxes, arrows, etc. to the image using the annotation tools in the Tool Box under 
Enhancement and Annotate.

7. Print the image using the PRINT button in the Tool Bar or the pull-down File menu option.

8. Analyze the sample using the analysis features in Tool Box (Analysis for quantitative analysis).

Contrast Adjustments
The Contrast Adjustments window allows for the best visualization possible of a sample utilizing the black, 
white, and gamma adjustments, as well as, image reverse and auto contrast. 

The image on the screen is made up of picture elements (pixels) in an array. Each pixel is assigned a brightness 
(or a gray scale value) level between black and white. A very bright image has most of its pixels registering 
high gray level values and conversely, a very dark image has most pixels registering low gray level values 
(approaching zero).

The distribution of these gray values to the image is determined by the Contrast Adjustment controls. These 
controls regulate the Black level, White level, and Gamma setting (brightness linearity), allowing adjustment of 
the display to obtain the best image possible. 

NOTE: These enhancement features modify the image display on the monitor only, and do not change the 
original quantitative data.

AlphaView software can also import RGB color images. The AlphaView Software automatically detects this 
process and the Contrast Adjustment tools are configured for color image adjustments.
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NOTE: An image can be enhanced using these tools and then saved as a modified file for publications. 
However, to preserve the original image information, it is recommended that the file be saved as a 
different file name when using the save modified.

Using the Contrast Adjustment Tools for Grayscale Images

There are three sliding scales found in the image control area to the right of the image. Below each scale is a 
box displaying a number that corresponds to the position of the slider. By adjusting these sliding scales, the 
image display can be optimized.

Figure 2-26: Contrast Adjustments Settings

Figure 2-26 displays the imaging display tools: Black level, White level, Gamma setting with B/W/G, Linear, Log, 
and Equalize options.

To adjust any of these settings, place the cursor on the slider. Click and hold down the left mouse button 
while dragging the slider to a new setting. As the slider is moved along the scale, the image display is updated, 
along with the change in numeric value. The arrows above and below the scale bars can also be clicked to 
change the settings in single unit increments, or, the user may type in a specific unit.

Black Level Adjustment 

The number beneath the Black Level scale corresponds to a gray level. There can be 256, 4095, or 65,536 
possible gray levels depending on the system type. For the example below, an 8 bit image will be used with 
256 total gray scale values. When the Black slider is at the very top of the scale, the number is 0. As the slider 
is moved downwards along the scale, the number increases and the image becomes progressively darker. This 
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is because all pixels at the specified gray level and lower are shown on the screen as black pixels. If the slider is 
set to 0, all the pixels whose gray levels are at 0 are shown as black. If the setting is then changed to 60, all the 
pixels between 0 and 60 are shown as black and the image appears darker.

Figure 2-27: Black Level Adjustment Example

White Level Adjustment

The number beneath the White Level scale also corresponds to a gray scale value. When the slider is at the 
very bottom of the scale, this number is 255. As the slider is moved upwards along the scale, the number 
decreases and the image becomes progressively lighter. This is because all pixels at the specified gray level 
value and above are shown on the screen as white pixels. For example, if the slider is set to 150, all the pixels 
between 150 and 255 are shown as white and the image appears lighter.   

Figure 2-28: White Level Adjustment Example

Gamma Setting Adjustment

Changing the Gamma setting affects the image brightness by adjusting the linearity of the image on the screen 
and printouts, but does not affect quantitative data. 
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The camera sees objects linearly while the human eye does not. When the Gamma setting is set to a value of 
1, the image is displayed as the camera sees it. This, however, is different from what the human eye detects. By 
adjusting the Gamma setting, the user can make the image on the screen correspond to what is seen when 
he/she looks directly at the object. We recommend a Gamma setting of 0.55 for best visual representation.

Figure 2-29: Gamma Setting Adjustment Example

The Auto Contrast Selection

The Auto Contrast feature will automatically scale the black and white values of an image to more tightly fit 
the gray scale intensity profiles (histogram). This selection will use different black and white values for different 
images depending upon their unique histograms. A more dramatic visual change will take place for low light 
level images (such as chemiluminescence) where smaller portions of the histogram are used. This selection 
can be turned on or off and will adjust differently for each image. 

The Reverse Button

The Reverse button inverts the gray levels of the displayed image, converting a positive image to negative, or 
vice versa. For instance, an image with black bands on a white background is converted into an image with 
white bands on a black background by simply clicking the Reverse button. Clicking the button a second time 
returns the image to its original form.

Figure 2-30: Original Image vs. Reversed Image
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NOTE: Reversing an image changes the way it is displayed on the screen, but does not change the 
quantitative data. For example, the bands in the above gel have the same density, regardless of whether 
the gel is displayed as white bands on a black background or black bands on a light background. For 
information on reversing pixel values, see Chapter 5, “Image Analysis Tools“.

The Equal Button 

The Equal button flattens the image to show all pixel values in the original image. Equal automatically adjusts 
the image display for maximum contrast which is beneficial for faint band detection.

Figure 2-31: Original and Equal Image

Making Linear, Log, or Equal Adjustments

Figure 2-32 shows an original image of film using default BWG settings. 
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Figure 2-32: Original Image of Film with Default BWG Settings

Figure 2-33 shows the image of film with linear Contrast Adjustments selected. The Linear tab provides mini-
mum and maximum adjustment tools from 0 to 100%. Linear stretches the grayscale range of the displayed 
image to the system dynamic range of 0-65,535 grayscales.

Figure 2-33: Contrast Adjustments—Linear Tab Settings

Figure 2-34 shows the image of film with log the Contrast Adjustments selected the log provides minimum 
and maximum adjustment tools from 0 to 100%. The Log performs a logarithmic adjustment to the grayscale 
range of the displayed image.
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Figure 2-34:  Contrast Adjustments—Log Tab

Figure 2-35 shows the image of film with equal Contrast Adjustments selected. The Equal option automati-
cally adjusts the image display for maximum contrast which is beneficial for faint band detection. 

Figure 2-35: Contrast Adjustments—Log Tab
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Automatic Enhancement

Figure 2-36: Automatic Enhance Levels

This function is ideal for new or inexperienced users of the system since it offers 9 levels of automatic image 
enhancement of the black, white, and gamma levels simultaneously. For an inexperienced user, in can be 
difficult to adjust each black, white, and gamma buttons to their respective optimal positions. By clicking on 
one of the nine Auto Enhance Level buttons, the image is optimized according to a unique level. Button 1 will 
make the image ‘darker’. Each increasing button click will ‘lighten’ up the image until button 9 is pressed which 
will make the image the ‘lightest’ possible.

To undo any Auto Enhance Levels, just press on the Reset button on the main interface.

Figure 2-37: Image Levels and Enhance Tool Examples

Imaging Tools

Tool Bar

The Tool Bar window provides intuitive icons for the most common functions in AlphaView.
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Figure 2-38: AlphaView Tool Bar

Icon Description

The Navigator icon starts the AlphaNavigator wizard.

The Open icon functions identically to the File Open function in the upper menu bar. This 
function is used to open previously saved images. Detailed instructions are available in Chapter 
3, “Drop-Down Menus“.

The Save and Save All icons function identically to the File > Save and File > Save All functions 
in the upper menu bar. This function is used to save captured images to the desired storage 
medium.

Once an image is displayed, it can be printed on the default printer by clicking the Print icon in 
the Tool Bar window display. Most printers can be configured through the Windows operating 
system to be the default printer. Refer to your Windows operating manual for more informa-
tion on installing a default printer.

The Zoom Out and Zoom In icons provide easy zooming ability while you are active in image 
enhancement or analysis functions providing increased versatility. Detailed instructions are avail-
able in Chapter 4, “Image Enhancement Tools“ as this function is also available in the Tool Box, 
Enhancement Tools. 

Assists the user to zoom in on a selected area, the average pixel is displayed.

The Fit in Screen icon adjusts zoom factor to fit image in available screen area.

The Image Drag icon is useful for to pan with a zoomed image. To activate this function, click 
the icon and move the mouse cursor to the image. The cursor will have changed to a small 
hand. Click the left mouse button and drag to move the image. When you are done, you can 
click the Image Drag icon again to deactivate it. 

NOTE: Image Drag is only active when the image is zoomed in beyond 1X (greater than 
100%). The icon is grayed out in other zoom modes.
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Compare View

Two or more images can be opened in compare view. To open compare view, click the Compare View 
icon.

If only two images are opened in the tab view, images will directly open in compare view. If more than two 
images are opened in tab view then a dialog box pops up, through which image can be selected to open in 
compare view.

The Saturation icon allows for a quick image display of saturation. Completely saturation black 
regions (gray scale 0) will turn green and saturated white regions (i.e. gray scale 255, 4095, 
65,535) will turn red. This is a useful tool to check for linearity of an image before analysis 
occurs. Saturation is a feature that is most important during the acquisition stages and is 
thoroughly detailed in the acquisition features of the system manuals.

The Image Overlay icon creates an RGB image from three grayscale images. Select the images 
for the Red, Green and Blue channels in the selection window

Clicking Reset returns the image to the system defaults as specified in the active default file. 
This is detailed later in Chapter 3, “Drop-Down Menus“.

Clear removes any overlays currently displayed on the image. This function can be useful if 
annotations or other displays obscure parts of the image.

Saves the analysis.

Loads an analysis.

The Notepad icon opens up a dialog box to allow the user to quickly track experimental 
conditions, comments, and any other details to be saved as an electronic copy for future 
reference. Detailed instructions are available in Chapter 3, “Drop-Down Menus“ as this Notepad 
function is duplicated in the Utilities function in the upper header bar.

The Open File Explorer opens windows file browser

The Compare Image icon allows comparing two or more images in compare view.

Icon Description
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Figure 2-39: Selecting Images in Compare View

If two images of same size are opened in compare view then synchronize checkbox, in status bar, will be avail-
able to use. By activating synchronize function scroll and zoom can be applied on both images together.

To switch back from compare view to tab view simply clicks on the Compare View icon; see Figure 2-40.

Figure 2-40: Switching Back from the Compare View

Another way is by drag one image tab to see the docking options as shown in Figure 2-41.
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Figure 2-41: How to Enter the Compare View

After selecting appropriate place, when you drop the image tab, compare view will be opened.

Figure 2-42: Compare View Result

Tool Box

The Tool Box window contains an intuitive interface for performing all image enhancement and analysis 
functions. 
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Figure 2-43: Tool Box

The Enhancement Tools option contains the controls for enhancing and adjusting the image. This includes 
software filtering, false colors, zoom factors, and other unique features. The Analysis Tools contain the 
controls for quantitative analysis including gel smiling corrections, band matching, Lane Profile densitometry, 
multiplex band analysis, molecular weight calculations, colony counting, and arrays. Both the Enhancement 
Tools and the Analysis Tools are detailed in Chapter 4, “Image Enhancement Tools“ and Chapter 5, “Image 
Analysis Tools“, respectively.
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Status Bar

The Status Bar is located on the bottom of the monitor and provides a real time display of the mouse cursor 
x, y position, the image zoom factor, and the grayscale intensity at the mouse cursor x, y position.

Figure 2-44: Status Bar
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Chapter 3:

Drop-Down Menus

Chapter Overview
• Main Menu

• File Menu

• Edit Menu

• Image Menu

• Setup Menu

• Overlay Menu

• Utilities Menu

• View Menu

• Window Menu

• Help Menu
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Main Menu
Across the top of the screen is a Windows menu bar containing several system operation functions. These 
include file saving and loading, edit, image, setup, overlay, file utilities, view, window and help functions. 

Figure 3-1: AlphaView Drop-Down Menu Bar

File Menu
Use this menu to save an image as a file, retrieve a previously saved image, select different printers, print an 
image to a parallel printer, overlay multiple images in RGB color channels, close an image, log-off of the system 
or exit the system. 

Figure 3-2: File Pull-Down Menu

File > Open Menu

This function opens an image, which has been previously saved as a TIF, GLP, BMP, PCX, TGA, PIC, JPG, PNG, 
FCZ or Macintosh® TIFF (MAC) file. 
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Figure 3-3: File > Open Dialog Box

Using the left mouse button, click on the name of the file to be loaded. That name is then highlighted in the 
list and appears in the text box below the File name prompt. 

Alternate disk drives can be accessed using the “Look In” dialog box.

Once the file has been selected, click on the Open button to load the file. (Alternatively, double-click on the 
file name.) The dialog box disappears and the selected image appears in the image window on the screen.

To dismiss the dialog box without loading an image, click on the Cancel button.

File > Save/Load Analysis

You can use Save/Load analysis feature from file drop-down menu, to save all your work and then load it back 
for later use.

NOTE: The load analysis menu item can only be accessed when the user opens any the analysis tools. If 
the image opened has an analysis saved, the item will be activated.
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Figure 3-4: Save/Load Analysis Feature

File > Close Menu

This function closes the image currently displayed on the screen.

File Save, Save As, Save Modified, and Save All Menus

Save allows original images to be saved in several different formats. Save As allows images that have 
previously been saved to be saved in a different location or as a different file type without affecting the original 
image. Save Modified saves the image as a 8-bit color image with annotations burned into the image. Save 
All saves all images in .tiff format only.

AlphaView has the ability to save files in several formats; see Figure 3-5.

Figure 3-5: File > Save As Dialog Box
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Enter a new file name in the text box adjacent to the File Name prompt. Next, choose a file type from the 
Save As type list. 

AlphaView will automatically give the appropriate 3-character extension. AlphaView will also create a file with 
the same base name and a .STP extension. This setup file saves information specific to this file, such as Black 
Level, White Level, Gamma Setting and 1D-Multi template placement. If the file is accessed later, these set-
tings will be recalled.

File Types
TIFF is the default file format for AlphaView files. TIFF is an acronym for “tagged image file format” and was 
developed as a flexible and machine-independent graphic file format. Saving as a TIFF file will allow users to 
double-click TIFF files from Windows Explorer and automatically launch the application on any machine that 
has AlphaView loaded on it. Please refer to “Preferences” on page 61 for information on how to customize 
the default file type. 

Mac TIFF is the Apple Macintosh version of the TIFF file format. Mac TIFF files have the extension .MAC so 
they can be easily distinguished from Windows TIFF files. Most software can distinguish between Mac and 
Windows TIFF formats and can accept either. AlphaView offers the option of both formats in the event that 
only one of the two is acceptable.

GLP is a proprietary file format that allows changes to only be made in AlphaView programs. It will accept 8-
bit and 16-bit images and cannot be opened in any other software program. 

BMP, PCX, TGA, PIC, JPG, GLP are additional graphic file formats which may be useful when saving an image 
for desktop publishing. These file formats can be imported directly into many Macintosh® and PC programs. 
(For more information, see Appendix A, “Opening AlphaView Files in Other Software Programs“.) 

NOTE: Do not use these formats to save images that will be analyzed later, since pixel data can be lost or 
altered when saving files in these formats. 

NOTE: Not all of the file types listed above can be saved as a 16 bit file. The AlphaView software allows 8 
bit Tiff images to be saved as BMP, JPG, or Tiff format. 16 bit Tiff images can only be saved as Tiff images. 
Some may require you to convert the image to an 8 bit file first. 
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Original versus Modified Files

An Original image file is one in which the data is saved in an unaltered form. This option should be selected if 
the image will be analyzed later. If the Black level, White level, or Gamma settings have been adjusted, the new 
values are saved but the pixel values are not altered. When this file is opened at a later time, AlphaView will 
display it with the values that were displayed when the image was saved, however, it is still possible to revert 
to the original raw image file by selecting Reset on the Tool Bar.

Annotation information cannot be saved with the Original image option. It can, however, be saved as an 
Overlay. Please refer to “Overlay” on page 56 for more information. 

If the image was saved as an original file using an older system, some distortion may occur when viewing it in 
desktop publishing or word processing programs. If this occurs, save a copy of the image in the modified for-
mat before importing it into another software package. 

An image that is saved as a modified file permanently retains the changes to the image’s Black level, White 
level, and Gamma setting. Annotations and any filtering performed are also saved with the image, replacing 
original image information with the new information. 

NOTE: If the image is saved as a Modified file it is converted to an 8-bit image. 

Print

This function sends the image to the default printer specified in Print Setup.

Printer Setup

This function displays a dialog box in which the settings for the parallel printer are specified. When all the 
pertinent printing preferences have been specified, click on the OK button. If you purchased a printer with 
AlphaView, this will be preset from the factory.
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Figure 3-6: Page Setup Dialog Box

Figure 3-7: Page Setup—Printer Dialog Box

For more information on using the Print menu, see the Windows manual.

Exit Function

The Exit function closes AlphaView. To restart AlphaView from Windows, double-click on the AlphaView 
icon.
AlphaImager HP, EP and EC User Guide



page 54 Chapter 3: Drop-Down Menus
Edit Menu
The Edit menu provides the ability to copy, crop, reset and remove any annotations or filters that have been 
added to the original image. 

Figure 3-8: Edit Pull-Down Menu

Edit Activation

To activate the Copy and Crop functionality, place a check mark next to Edit Activation. This will turn the 
mouse cursor into a + sign that will allow you to highlight the region of interest for the image. After Edit 
Activation is highlighted, the desired area of interest is drawn using the mouse. 

Figure 3-9: Ready to Crop or Copy
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Once this is completed, you can select either the Copy or Crop function in the Edit menu options.

Copy and Crop

Copy will copy the desired area of interest into the Windows Clipboard and allow you to paste into any 
desktop publishing package (i.e. Word, Excel, Adobe Photoshop, etc.). 

Crop will display just the region of interest as the active window in the AlphaView interface.

Figure 3-10: AlphaView Interface—Sample Crop 1

Reset and Clear Options

The Reset option configures the Black, White, and Gamma settings to default settings. The Clear option 
removes any annotations that are present on the image.

Image Menu
The Image menu provides the ability to perform a variety of image processing functions.
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Figure 3-11: Image Pull-Down Menu

Overlay

To superimpose images, use the Overlay function under the Image File menu. This function will display 
separate multiplexed images or a RGB color image as a compiled image with the appropriate color channel 
images added together. A simple way to acquire multiple images for this function is to use the Movie Mode 
function in image acquisition and acquire a series of identical images.

The Overlay Images option allows you to overlay up to three different images with three different color 
channels. You can select the Browse button for each color channel and select the appropriate images to be 
used for generating a color image. For example, if you have a saved grayscale images of an identical gel taken 
with a SYPRO red filter for the red stain and a SYBR green filter for the green stain, you can choose these 
images in the appropriate Red and Green Channels to generate a composite image with the red and green 
colors mapped onto the compiled image. 

NOTE: The images must be the same bit depth and resolution for the software to overlay the images.

Equalize

The equalize option performs a duplicate function to the Equal option in the Contrast Adjustment Window. 
This is a useful function for detecting faint bands on a sample.

Arithmetic

The Arithmetic function is used to add, subtract, average and divide several images together to generate a 
compiled image. 
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Figure 3-12: Image > Arithmetic Menu

To average a set of images together open one of the images in the set and then select ‘Average a Set…’ under 
the Image pull-down menu. A prompt will appear allowing the user to select all of the images that for the set. 
It is possible to browse the directories looking on the network drives and removable media if necessary. Once 
all of the images have been selected click on the open button to finish the image set. The resulting image is an 
average of all of the images together. This is a useful function for extending the dynamic range on a set of sim-
ilar images by allowing bright spots and faint spots to be seen on the same image. 

The other functions are adding, subtracting and dividing images together. Adding together images is frequently 
used for colorimetric markers run together with chemiluminescent samples. Subtracting images is often used 
to remove noise from a sample by running dark images first and subtracting them out of the final image.   The 
most common application for quotient is for those technical users who run their own flat field corrections. 
This can be done using the Flat Field Calibrate selection under the Image pull down menu which will be 
described in detail later in this section. 

All three of these arithmetic functions are performed by opening the main image that will be adjusted. Next 
select the appropriate arithmetic function under the image pull down menu. Then select the image that is to 
be added, subtracted or divided from the original image and select open. The dialog box will disappear and 
the resultant image will appear.

NOTE: Images that have been arithmetically altered are ideal for publications and documentation, how-
ever, they are strongly not recommended for analysis as the pixel values have been adjusted. 

Conversion

Because AlphaView can generate 16-bit files, the conversion option is useful when an image is to be imported 
into a program that only accepts 8-bit images. Choosing this option will convert a 16-bit image into an 8-bit 
image.

A 48-bit color image can be converted into a 16 bit grayscale image by simply averaging the RGB values for 
each pixel.
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Figure 3-13: Image > Conversion Menu

Resize

The Resize function is to resize an image to a specific dimension for use in graphical presentations. You have 
the option to ‘Preserve aspect ratio’ to avoid image dimensional distortion, or you can deactivate this function 
and configure the image resolution to the desired width and height dimensions. 

Figure 3-14: Resize Image Dialog Box

NOTE: It is recommended that you DO NOT perform quantitative analysis on resized images.

Image Information

The Image Information function provides a dialog box with all detailed image properties. To remove this 
dialog box from the screen, click OK.
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Figure 3-15: Image Information Dialog Box

Setup Menu
This menu customizes the system settings by allowing users to save default parameter preferences and 
customize the software settings. 

Figure 3-16: Setup Pull-Down Menu
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Print Info

Figure 3-17: Setup > Print Info Menu

When printing an image, basic image information is included on the print. This includes the exposure time, 
the Black level, White level, and Gamma setting, the date and time the image file was generated, an image ID 
number, and the name of the file to which the image is stored. 

To print this information at the top of the print, choose Top from this menu. To print at the bottom of the 
print, choose Bottom. 

NOTE: Printing image information at the top or bottom of a print may obscure a small portion of the 
image. To print the image with no information on it, choose Off.

Print Mode

AlphaView software provides custom printing options. 

Figure 3-18: Setup > Print Mode Menu

Printing can be achieved in three different methods:

• Full Image—Prints the original image. Does not print zoomed images or images overlaid with data 
screens.

• Screen Dump—Prints the imaging area. Well suited for printing images overlaid with data screens and/
or graphs, zoomed images, etc.

• Image Window—Prints the highlighted window.
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Print Date

Under the Setup menu there is a selection labeled “Print Info”. This allows the user to change the format in 
which the date is printed. The choices are MM/DD/YYYY and DD/MM/YYYY.

Preferences

In order to change the preferences of the system, you will need to find the administrator of the AlphaView 
software program to log in; the login is enforced only on data altering tool tabs (image acquire, cabinet 
settings, and auto enhancement).

Figure 3-19: User Login Dialog Box

There are five tabs in the Preferences menu (the AlphaView Stand Alone software does not contain the 
Image Acquire or Cabinet Settings tabs):

• General—Configures prompts and file saving/opening formats.
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Figure 3-20: Preferences—General Tab

• Image Acquire—Inverts the image seen by the camera and adjusts the ROI values.

Figure 3-21: Preferences—Image Acquire Tab
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NOTE: Cell Biosciences does not recommend that you make any changes to these settings without contact-
ing technical support first. Some features on this tab are not currently implemented in the software.

• Cabinet Settings—Used for adjusting the port settings and customizing filter positions on the cabinet.

Figure 3-22: Preferences—Cabinet Settings Tab

• Auto Enhancements—Used to customize the Auto Enhance Levels located in the Image Enhancement 
tool box.
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Figure 3-23: Preferences—Auto Enhancement Tab

To make changes to the preferences, select your change by typing in a new value or select/de-select the 
appropriate box with a check mark and then select apply. Some settings may require that the software be re-
started for the change to take effect.

• Analysis Tools—Used to show/hide additional image analysis tools. Any change in the settings will 
require software be re-started for the change to take effect.

Figure 3-24: Preferences—Analysis Tools Tab
AlphaImager HP, EP and EC User Guide



Overlay Menu page 65
Overlay Menu
The Overlay menu provides a means of saving and retrieving annotation overlays. This is especially useful 
when a standard gel format is run repeatedly. Lane numbers, molecular weight marker sizes, and other 
pertinent information can be stored as an Overlay file and retrieved at a later date. This eliminates the need 
to re-enter the information each time a new image is captured. 

Figure 3-25: Overlay Pull-Down Menu

An overlay is any set of annotations (text, boxes, arrows, etc.) that have been drawn on the image. They can 
be saved as a group and opened later.   If repetitive samples are being imaged, an overlay eliminates the need 
to re-enter the same information (such as lane numbers, standard sizes, etc.) continually.

Load Overlay

The Load Overlay function allows Overlay files to be retrieved and applied to the image currently displayed. 

Opening an Overlay after an image has been captured places the annotations on top of the image. They can 
be stored as part of the image by saving the file as a modified file. Please refer to “File Save, Save As, Save 
Modified, and Save All Menus” on page 50 for more information.

Select the name of the file to be loaded. (If necessary, change the directory or drive.) The file name is then 
highlighted in the list and appears in the text box below the Filename prompt.

Once the file has been selected, click on the OK button to load the file. (Alternatively, double-click on the file 
name.) The dialog box disappears and the annotations in the selected file appear on the image.

To dismiss the dialog box without loading annotations, click on the CANCEL button.

Save Overlay

Once annotations have been made, select Overlay > Save Overlay.
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Figure 3-26: Save Overlay File Selection Dialog Box

Enter a new file name in the text box below the File Name prompt. AlphaView will automatically give the 
appropriate 3-character extension.

The current directory is the one in which the new overlay file will be saved. If necessary, change the directory 
or drive as described in Section 3.1.

Once a name has been entered and the appropriate directory has been accessed, click the SAVE button to 
save the overlay file.

Overlay Libraries

AlphaView contains a library of overlays that can be accessed through the Load Overlay function described 
above. This library of overlays is stored in the Image folder located in the AlphaView directory:

08WHITE.OVR / 08BLACK.OVR 8 lane labels in white/black

10WHITE.OVR / 10BLACK.OVR 10 lane labels in white/black

12WHITE.OVR / 12BLACK.OVR 12 lane labels in white/black

15WHITE.OVR / 15BLACK.OVR 15 lane labels in white/black
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The objects in these overlays can be repositioned, resized, re-colored, copied or deleted as needed.

Show Annotation

To displays or hides annotations in Analysis modules.

Utilities Menu
A number of functions are now handled by Windows programs. To access many of these programs while in 
AlphaView, open the Utilities menu and select the program of choice.

Figure 3-27: Utilities Pull-Down Menu

Notepad

The Notepad is a blank screen that allows the user to make notes about the experiment and save them as an 
ASCII file. The Notepad is useful for saving any imaging comments or experimental conditions with the saved 
image for future reference.

24WHITE.OVR / 24BLACK.OVR 24 lane labels in white/black

HINDIII.OVR λHindIII label
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Figure 3-28: Notepad Display Window

Explorer

Windows Explorer allows access to files and other information saved on the local machine or the network, if 
applicable. 
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Figure 3-29: Windows Explorer Window

View Menu
The View menu provides the ability to control the display of the on-screen control tools as well as provide 
image enhancement abilities.

Figure 3-30: View Pull-Down Menu
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Default Tools Position

Four (4) main control windows exist within AlphaView: Tool Bar, Contrast Adjustment, Tool Box, and Status 
Bar :

Figure 3-31: Tool Bar

Figure 3-32: Contrast Adjustments Window

Figure 3-33: ToolBox Window

Figure 3-34: Status Bar
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These control windows automatically open when AlphaView is launched for additional ease of use and to 
generate a common ‘look and feel’. Since these items are ‘floating’ tools, you can click on Default Tools 
Position to move all tools to the default locations for more intuitive operation. Lastly, except for the status bar, 
it is possible to select and move any of the other windows to a custom location. 

Zoom Functions

Additional options provide the ability to Zoom In and Zoom Out on the image, Zoom to 1X and to Fit to 
Screen. 

NOTE: Zoom In and Zoom Out are duplicate functions for the Zoom In and Zoom Out icons in the 
ToolBar and the Zoom options in the Enhancement Tools.

Window Menu
The Window menu provides the ability to navigate from one image window to next image window. It also 
allows user to close all documents.

Figure 3-35: Window Pull-Down Menu
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Help Menu

Figure 3-36: Help Pull-Down Menu

Complete instructions on how to use the software along with detailed explanations of all features are avail-
able from the AlphaView Help option of the Help menu. 

To display system information, select the About option in the Help menu. This button accesses a pop-up box 
(see Figure 3-37), which shows the system serial number and software version number. Use this information 
when contacting Cell Biosciences for technical support, software upgrades, etc.

Figure 3-37: AlphaView—About Help Display

To close the box, click on the OK button.
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Chapter 4:

Image Enhancement Tools

Chapter Overview
• Tool Box Enhancement Tab

• Zoom

• Histogram

• Rotate-Flip

• Annotate

• False Color

• Filter

• Movie Mode
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Tool Box Enhancement Tab
Image enhancement tools are contained within the Tool Box as indicated. This tool set allows the user to 
zoom the image, rotate-flip the image, show the image histogram, perform automatic image enhancement, 
annotate on the image, display false colors, apply software filters, and activate the Movie function. 

NOTE: Many image enhancement tools do not function with multichannel images.

Figure 4-1: Tool Box

Zoom

Figure 4-2: Zoom Tool

The Zoom tool function magnifies an image, making details easier to see, and allows movement around the 
magnified image.
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An image can be displayed ¼x, ½x, 1x, 2x, 4x, or 8x larger than the original display by clicking on the 
appropriate buttons. To return to the original magnification, click on the 1X button.

When an image is magnified, only part of it can be displayed on the screen at any one time. To see different 
parts of the magnified image, use the green Pan Control box. The outer box shows a thumbnail of the entire 
image while the inner green box represents the portion currently displayed on the screen. 

To view different regions of a magnified image, move the cursor into the inner box. Click and hold down the 
left mouse button. The cursor changes to a hand; use it to drag the green box until the desired region of the 
image appears on the screen.

Alternatively, use the scroll bars in the image window to move the image up or down, and left or right.

On-screen Zoom tools are also available located on the main Tool Bar. This function duplicates the Zoom 
tool in Tool Box, and also allows for Image Drag to easily pan the image during any analysis functions located 
in “Zoom” on page 74 (in the Analysis Tools option).

Image Drag icon in ToolBar

Zoom Icons in ToolBar

Histogram
The histogram is a graphical display of the proportion of pixels assigned to each of the 4,095 gray levels.

Figure 4-3: Histogram Display in the Tool Box

The image is made up of picture elements (pixels) having brightness levels ranging from black to white. A very 
bright image will have most of its pixels registering high gray levels and conversely, a very dark image will have 
most pixels with low gray levels (approaching zero).
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The histogram is displayed in the lower left corner of the screen, below the image window. The horizontal 
axis represents the gray scale range: black at the left end and white at the right end, with levels of gray in 
between. The number of pixels registering a particular gray level determines the height of each bar along the 
axis.

A Coomassie blue-stained protein gel visualized with a white light box has a histogram reflecting mostly bright 
pixels: 

Figure 4-4: Histogram of a Typical Coomassie Gel

Most of the pixels are found in the light portion of this histogram. The dark bands represent a small number 
of pixels and include a variety of gray values, and therefore do not show up as a single peak.

The histogram function is particularly useful to verify that an image spans the maximum range of gray levels. 
When an image is to be used for analysis, it is especially important that the gray level range be as large as 
possible. If an image does not include most of the gray levels, we recommend repeating the image capturing 
process.
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Rotate-Flip

Figure 4-5: The Rotate-Flip Tool

The Rotate-Flip tool function rotates the image in a clockwise or counterclockwise direction by 1° increments 
up to a maximum of 90° in either direction. This is a useful tool if the image is not aligned properly during the 
capturing process. 

To rotate an image, click and hold down on the center sliding bar with the left mouse button and move it left 
or right until the desired angle of rotation appears in the rotate box. Release the left mouse button and image 
will rotate to the desired angle. To undo a rotation, just click on the Undo button. Also, a Flip option allows 
for the image to be rotated 180° in a vertical or horizontal fashion.

The Reset button on the main software interface will also remove any rotations or image flips and return to 
the display to the original image.
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Figure 4-6: Rotate-Flip Tool Images

Figure 4-7: Rotate-Flip Tool Controls

Annotate
The annotation tools, include a number of different options for adding text (including Greek symbols), draw-
ing arrows and otherwise marking an image. 
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NOTE: These tools are for annotation only. For information on drawing objects for quantitation purposes, 
see Chapter 5, “Image Analysis Tools“.

Figure 4-8: Annotate Toolbox

Object Attributes

Use the COLOR, PEN WIDTH, PEN STYLE, LINE ENDS, TEXT STYLE and/or TEXT ORIENT menus to 
specify object attributes. Attributes can be assigned to the cursor before drawing or typing. Alternatively, they 
can be assigned to an object while it is in “edit” mode (see the following subsections for more details).

Annotation Colors

Annotations can be displayed in a variety of colors. The color options are displayed by clicking the COLOR 
radio button. To select a color, simply click the cursor on the button labeled with the desired color. The color 
button appears depressed, indicating that it is selected. Any annotations subsequently entered will appear in 
that color. It should be noted, however, that annotations are printed in gray scale on the video printer. Further, 
when an image is saved as a modified image, the annotations are saved in gray-scale, not color.

Line Thickness

The PEN WIDTH option specifies the thickness of lines when using the freehand, lines, box and circle drawing 
tools. Click on the appropriate checkbox for the desired width. All annotations subsequently entered will 
appear at that width.
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Figure 4-9: Pen Width Selection Tools

Line Types

The PEN STYLE option specifies the style of lines when using the freehand, lines, box and circle drawing tools. 
Click on the appropriate checkbox for the desired style. All annotations subsequently entered will appear in 
that style. 

NOTE: These pen styles only work with a thin line (see the “Line Thickness” section).

Figure 4-10: Pen Style Selection Tools
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Arrows and Straight Lines

The LINE ENDS option specifies the style of the ends of straight lines (no arrow, single arrow or double 
arrow). Click on the appropriate checkbox for the desired style. 

NOTE: These line ends work with any line thickness.

Figure 4-11: Line Ends Selection Tools

Text Background and Font

The TEXT STYLE option specifies the style of text. Click on the appropriate checkbox to show text with or 
without a background. An opaque background is useful if annotations will be made on an image that has wide 
variations in gray scale. By using an opaque background, text will not be “lost” in the background of the image.
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Figure 4-12: Text Style Selection Tools

This is also the window in which specific font is chosen. When the Set Font button is depressed, a selection 
box appears, from which text style can be chosen.

Figure 4-13: Font Selection Dialog Box

NOTE: To choose Greek symbols (such as α, β, λ, π, and θ) choose the Symbol font: 
a b c d e f g h i j k l m n o p q r s t u v w x y z
αβχδεφγηιϕκλμνοπθρστυϖωξψζ
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Text Orientation

In the TEXT ORIENT window, select whether text should be oriented vertically, horizontally, or at an angle 
(in 15° increments).

Figure 4-14: Text Orient Selection Tools

NOTE: Only rotate fonts that are True Type (indicated by TT in front of the name); other fonts (such as 
Courier and Fixedsys) do not re-scale properly, giving unpredictable results.

Drawing Tools

Once the object attributes have been defined, click the cursor on any of the drawing tool buttons to assign 
the function associated with that button to the mouse. The cursor will change from an arrow to a cross, 
indicating that AlphaView is in “drawing” mode.

After selecting a drawing tool, move the cursor to the correct position on the image to begin drawing. Press 
and hold the left mouse button and move the mouse to the end point of the object to be drawn. Release the 
left button, and the object should appear.

Boxes will appear at the corners of the new object and the cursor will revert to an arrow, indicating that 
AlphaView is now in “edit” mode. At this point, the object can be resized or repositioned. The color, pen 
thickness, line type, etc. can also be changed, simply by clicking on the desired choice (as described in “Object 
Attributes,” starting on page 79).
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To draw another object, click the right mouse button to return to “draw” mode, or click on one of the 
drawing tool icons.

Table 4-1: Drawing Tool Icon Descriptions

Icon Description

The selection tool, allows the user to select all drawing for further operations, such as vertical 
alignment.

The button labeled with an "ABC" adds text to the image. Place the cursor at the location on the 
image where the left edge of the text should appear. Click the left mouse button and begin typing. 
To place another piece of text, click where it should be placed. Once all text is entered, click on 
the right mouse button. To edit text, double-click on it. An edit window will appear, in which 
changes can be made. To change fonts, see “Text Background and Font,” starting on page 81.

The button labeled with a pencil icon allows the user to draw lines freehand. After clicking on the 
pencil, move the cursor to the correct position on the image to begin drawing. Press and hold the 
left mouse button. Using the mouse, move the cursor as if it were a pencil. When finished drawing, 
release the mouse button.

The button labeled with a diagonal line and arrow, draws arrows and straight lines. After clicking on 
the button, move the cursor to the position on the image where the line should begin. Press and 
hold the left mouse button. Using the mouse, move the cursor to the other end point of the line 
then release the mouse button. The arrow can be adjusted by clicking on one of the boxes at the 
end (the other will serve as an anchor point) or by clicking in the middle to drag the entire arrow.

The button labeled with angles and arrows on its side is a line drawing tool, very similar to the one 
described above. The significant difference is that this tool limits the angle that the line can be 
drawn to increments of 45°.

The button labeled with a square draws a rectangle or square of any size on the image. After 
clicking on the button, move the cursor to the position that should correspond to one of the cor-
ners of the rectangle. Press and hold the left mouse button. Using the mouse, move the cursor to 
enlarge the rectangle. When it reaches the desired size, release the left mouse button.

The button labeled with a circle draws a circle of any size. After clicking on the button, move the 
cursor to the position on the image where the circle should be started. Press and hold the left 
mouse button. Using the mouse, move the cursor to enlarge the circle. When the circle reaches 
the desired size, release the left mouse button.
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Hint: to draw a perfect circle around a portion of an image, first visualize a square surrounding the area of 
interest. Position the mouse in the upper left hand corner of the square. Click and drag the mouse down 
across the area of interest at a 45° angle until the circle encloses the area of interest.

 

Sample Annotations

Figure 4-15: Sample Annotations

Annotated image showing: freehand drawings, lines with various characteristics, circles, squares, text with 
various characteristics

Editing Tools

When the cursor is in “edit” mode, it can be clicked on an object to select it. 

NOTE: The cursor can be toggled between “edit” and “drawing” modes by clicking the right mouse button. 

When an object is selected, small square boxes appear at the corners. Selected objects can be resized, 
copied, deleted or moved:
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• To resize an object, click on one of the gray boxes at the corners of its perimeter and drag the box 
until the object reaches the desired size. 

• To copy an object, use the Copy tool.

• To delete an object, use the Cut tool or the Eraser.

• To move an object, click within its boundary and drag it into the desired location. 

To select more than one object, outline them with the mouse; any objects that fall completely within the 
outline drawn will be selected. 

NOTE: The entire object must be enclosed by the cursor’s movement in order to be selected.

Figure 4-16: A Selected Object
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Table 4-2: Editing Tools

False Color
These tools consist of eleven pre-defined color palettes that can be applied to an image. To select a palette, 
simply click on one of the four buttons labeled Gray Palette, High-Low, Next or Previous.

Icon Description

Once an object or group of objects has been selected, clicking on the Cut tool deletes it from the 
image.

The Copy tool makes an exact copy of the selected object. The new object becomes the 
selected object, and can be repositioned by placing the cursor within the object’s boundary and 
moving it to the desired location.

The Horizontal Alignment tool aligns annotations in a straight horizontal line. This is especially 
useful for labeling lanes, etc. To use this tool, draw text on the image, select it, click the Horizontal 
Alignment tool, then deselect the text. The text will now be aligned in a straight line across the 
image.

The Vertical Alignment tool aligns annotations in a straight vertical line. This is especially useful for 
labeling markers, etc. To use this tool, draw text on the image, select it, click the Vertical Align-
ment tool, then deselect the text. The text will now be aligned in a straight line down the image.
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Figure 4-17: False Color Selection Box

When a palette is selected, its range of colors is displayed to the left of the palette buttons and automatically 
applied to the image. To apply a different palette to the image, click Next or Previous. 

NOTE: Changes in Black level, White level, and Gamma setting can alter the effect of each of the palettes, 
and can enhance the results produced.

Gray Scale (Palette 0)

This is the default or standard gray scale, consisting of different gray levels, ranging from black to white.

High–Low (Palette 1)

This is a modified gray scale palette in which black is replaced with green, and white is replaced with red. 
Over- and under-exposed areas of the image are thus shown as green or red, while areas within the linear 
range of the CCD chip are shown in gray scale. The Saturation Palette is especially useful during quantitation, 
as areas outside the linear range of the instrument do not give accurate quantitative information. This palette 
allows the user to avoid those areas during quantitative analysis.

This palette can also be accessed by clicking the Show Saturation checkbox in the Camera Setup and Preview 
function (accessible by clicking on the Camera icon in the Tool Bar window)

Other Palettes

These are color substitution palettes in which the gray levels are translated into different color ranges. These 
palettes can be useful to help distinguish features and highlight details on an image. 
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• Palette 2 maps the gray scale levels to a red/green/blue palette. Values of 0 are mapped to red; 
saturated to blue, and values in between to green.

• Palette 3 maps the gray scale levels to a red/green/blue palette. Values of 0 are mapped to blue; 
saturated to green, and values in between to red.

• Palette 4 maps the gray scale levels to a red/green/blue palette. Values of 0 are mapped to green; 
saturated to red, and values in between to blue.

• Palette 5 maps the gray scale levels to a cyan/magenta/yellow palette. Values of 0 are mapped to cyan; 
saturated to yellow, and values in between to magenta.

• Palette 6 maps the gray scale levels to a cyan/magenta/yellow palette. Values of 0 are mapped to 
yellow; saturated to magenta, and values in between to cyan.

• Palette 7 maps the gray scale levels to a cyan/magenta/yellow palette. Values of 0 are mapped to 
magenta; saturated to cyan, and values in between to yellow.

• Palette 8 maps the gray scale levels to shades of red palette. This palette may be useful when viewing 
red color images.

• Palette 9 maps the gray scale levels to a red palette. Values of 0 are mapped to dark red; saturated to 
white, and values in between to shades of red.

• Palette 10 maps the gray scale levels to shades of blue palette. This palette may be useful when viewing 
blue color images.

• Palette 11 maps the gray scale levels to a blue palette. Values of 0 are mapped to dark blue; saturated 
to white, and values in between to shades of blue. This palette may be useful when printing an image 
of a Coomassie-stained protein gel onto a color printer.

• Palette 12 maps the gray scale levels to shades of green palette. This palette may be useful when 
viewing green color images.

• Palette 13 maps the gray scale levels to a green palette. Values of 0 are mapped to dark green; 
saturated to white, and values in between to shades of green. This palette may be useful when printing 
an image of a SYBR® Green I-stained protein gel onto a color printer.

• Palette 14 maps the gray scale levels to an orange palette. Values of 0 are mapped to dark orange; 
saturated to white, and values in between to shades of orange. This palette may be useful when 
printing an image of an EtBr-stained gel onto a color printer.
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Filter

Figure 4-18: Filters Toolbox with 3-D (Contour) Selected

AlphaView includes a variety of enhancement filters that can improve the appearance of an image. Some 
filters sharpen detail, others smooth and reduce random noise. Still others help visualize edges and separate 
closely spaced bands or objects. Depending upon the unique characteristics of an image, the results of each 
filtering operation vary. Assess the characteristics of the image and then select the filter designed to minimize 
its imperfections.

When an image is filtered, the original image information is replaced with the results of the filtering operation. 
As a result, the original image information is altered. To avoid losing the original image, save it as an original 
TIFF file before applying a filter.

When the FILTERS button is selected, a pop-up box appears. If the desired filter is not shown, choose MORE 
to display more filters. One or many filters can be applied to a single image. 

Figure 4-19: Filters Toolbox with Sharpen Highlighted
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Figure 4-20: Filters Toolbox with More Selected

General Information

To enhance an image, filters change the value assigned to each pixel. The new value assigned to a pixel is 
determined based on the values of the other pixels in its local vicinity (or “neighborhood”). The 
neighborhood is a two-dimensional matrix of pixel values, where each dimension has an odd number of 
elements. The “pixel of interest” is the one at the center of the neighborhood. This is the pixel whose old 
value is being replaced with a new one as the result of the filtering algorithm.

The pixels in a neighborhood provide information about the brightness trend. This information is important 
to the filtering process. The brightness trend is also referred to as the “spatial frequency.” Images with high 
spatial frequency content contain large, closely spaced changes in pixel values. For example, on a black and 
white checkerboard, the smaller the squares, the higher the frequency content.

Images with low spatial frequency content (for example, images of clouds) contain large areas of slowly 
changing pixel values.

Most of the filter options available (with the exception of the Noise filters) use a weighted summation process 
to determine the value assigned to the pixel of interest. Each pixel in a 3x3 neighborhood is multiplied by a 
“convolution kernel” having the same dimensions. The resulting sum is assigned to the pixel of interest.
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Each element of the convolution kernel is a weighting factor, also called a “convolution coefficient.” The size 
and arrangement of these weighting factors determine the type of transformation the image will undergo. 
Changing a weighting factor influences the overall sum and, therefore, affects the value given to the pixel of 
interest.

Sharpening Filters

These filters can increase image sharpness and provide edge enhancement. However image noise may be 
enhanced as well. These filters accentuate the high-frequency details of an image while leaving the 
low-frequency content intact. High frequency portions of the image get brighter while low frequency portions 
become black. 

Sharpen level 9 (high) has the largest effect on the image. Sharpen level 5 has an intermediate effect. Sharpen 
1 (low) has the most subtle effect on the image. 9 different sharpening levels are available for optimization of 
the image.

Noise Filters

This filtering process uses the values of the pixels contained in the area surrounding a pixel to determine the 
new value given to the pixel of interest. The noise filter sorts the pixels in the neighborhood into ascending 
order and picks the middle or median pixel value as the new value for the pixel of interest. Three levels of 
noise reduction are available.

Despeckle Filters

The despeckle filter is a type of smoothing filter based on data rejection. Pixels in the neighborhood (usually 
the adjacent pixels) are used as a data set upon which the average and standard deviation of the set are 
calculated. If the pixel of interest (the center of the neighborhood) is different from the neighborhood average 
(either greater or lesser) by a threshold (a multiple of the standard deviation) it is replaced by the average 
value. 

The effect of the filter is to “smooth” pixels that are much different from their neighbors. Artifacts such as hot 
pixels, cosmic rays etc. are commonly rejected by this type of filter. The filter strength is controlled by the 
threshold factor. For large factors very little data is rejected as only very large deviations are required for 
rejection, where as, low thresholds result in more smoothing. (For example, setting #1 results in outliers of 1 
standard deviation greater or lesser than the neighborhood average to be corrected for, setting #2 results in 
outliers of 2.5 standard deviations to be corrected for and setting #3 results in outliers of 5 standard devia-
tions to be corrected for.)

These filters are particularly effective in eliminating random noise contained in an image and produce less 
blurring than the noise filters.
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3-D (Contour) Filters

These filters are particularly useful for visualizing faint bands. They produce a “3-D” effect, defining edges and 
making details easier to see.

3-D level 9 (high) has the largest effect on the image. 3-D level 5 has an intermediate effect 3-D level 1 (low) 
has the least effect on the image. Nine different 3-D levels are available for optimization of the image.

In addition, 3-D allows the user to control the ‘direction’ of the 3-D shadowing effect. Once the level is 
refined, just click on a direction arrow to visualize the shadowing adjustment. The default shadow direction is 
in the lower right hand corner direction and 9 different directions are available.

Figure 4-21: 3D Image Examples

Figure 4-22: 3D Image Controls
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Smoothing Filters

These filters are very useful for reducing the visual noise present in an image. When a smoothing filter is 
applied to an image, rapid changes in intensity are averaged out with the remaining pixels in the 
neighborhood, thereby decreasing the high frequency content. The visual result is a slight smoothing of the 
image because sharp pixel transitions are averaged with their surroundings. 

Smooth High has the largest effect on the image. Smooth Med has an intermediate effect. Smooth Low has 
the most subtle effect on the image.

Edge Filters

These filters use Laplacian enhancement to highlight edges, regardless of direction. All edge-enhancement 
operations attenuate the low frequencies of the image. Regions of constant intensity or linearly increasing 
intensity become black as a result of these transformations, and regions of rapidly changing intensity values are 
highlighted. 

NOTE: The White level may need to be adjusted after using the Edge filters in order to see the result of 
this filtering process.

Horizontal Edge Filter

This filter brightens horizontal edges. This can be useful in pinpointing bands on a gel. The horizontal edge 
filter (Horz. Edge) enhances image edges by shifting an image vertically by one pixel and then subtracting the 
shifted image from the original. In an area of constant pixel intensity, the subtraction yields black pixel values. 
At an edge, which is an area with large changes in intensity, the subtraction yields light-colored pixel values. 
The larger the difference in intensities, the lighter the resultant pixels. 

NOTE: After applying the horizontal edge filter the entire image may appear black, and might require 
reducing the White level in order to better visualize the results.

Vertical Edge Filter

This filter (Vert. Edge) brightens vertical edges using the approach described for the horizontal edge filter (see 
above), except that the image is shifted horizontally before the shifted image is subtracted from the original. In 
this case, the vertical edges produce light-colored pixel values. As in the horizontal edge filter, it may be nec-
essary to adjust the White level in order to better visualize the results of this filtering process.
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Custom Filter

This function allows the use of customized filters. Using the weighting factors of the other filters as a frame of 
reference, experiment with new weighting factor values. 

Undo Button

The upper right button is labeled Undo. This reverses the last filtering process applied to an image. To revert 
the image to its original state after multiple filters have been applied, press the Reset button on the main 
interface.

Examples of Filter Results

Figure 4-23: Examples of Filter Results

Movie Mode
To open and play existing movies, click on the Movie Mode tab in the Enhancement Tools. 
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Figure 4-24: Movie Mode In the Enhancement Tools

Click the Open button to open and play a previously recorded movie. To record a movie, click on the 
Record button. This will launch the Camera Setup and Preview window. Please refer to “Movie Mode” on 
page 19 for detailed instructions on recording movies.
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Chapter 5:

Image Analysis Tools

Chapter Overview
• Tool Box Analysis Tools Tab

• Molecular Weight Determination

• Colony Count

• Band Analysis Tools

• Lane Profile

• Additional Analysis Tools
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Tool Box Analysis Tools Tab
Default image analysis tools are contained within the Tool Box as indicated.   This tool set allows the user to 
perform molecular weight determinations, automatic counting of colonies and cells, multiplex band analysis 
and lane profile densitometry.

Figure 5-1: Default Analysis Tools in the ToolBox

Molecular Weight Determination
The Molecular Weight button (in Tool Box, Analysis Tools) opens a set of tools for entering the values of 
known molecular weight markers and determining the molecular weights of unknown bands on the image. 
When the Molecular Weight button is selected, a function box appears in the area to the lower left of the 
screen, and a data box appears on the image. (If the data window obscures part of the image containing 
bands of interest, it can be moved.)
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Figure 5-2: Molecular Weight Tools

Figure 5-3: Molecular Weight Data Box

At the top of the data box is a bar with two menus: Marker and Query. The area below the menu bar is 
divided into two sections. Molecular weight marker data is displayed in the upper section and the calculated 
or query data is displayed in the lower section.
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Entering Known Molecular Weights for Markers

An unlimited number of molecular weight standards can be defined, either all in one lane, or in multiple lanes. 
To input markers, open the Marker menu and select Add Marker. 

NOTE: To enter standards from previously-saved files, see “Applying a Set of Saved Markers” on page 103.

Notice that the cursor flashes and has a short, horizontal line associated with it. Move the cursor to the lane 
containing the molecular weight standards. Beginning at the top of the lane, position the cursor so the 
horizontal line is aligned with the band. 

If the Snap to Peak function has been activated, the cursor jumps to the highest pixel value in the band as 
the cursor approaches it. If bands are so tightly spaced that the line is not coinciding with the band, turn off 
Snap to Peak and place the marker on the band manually.

When the horizontal line is positioned correctly, click the left mouse button. A dialog box appears requesting 
the band's molecular weight. Using the numeric keypad in the dialog box (or the numbers on the keyboard), 
enter the known molecular weight. Alternatively, enter the value using the keyboard.

After entering the molecular weight, press either the OK button in the dialog box (or the <Enter> key on the 
keyboard). The dialog box disappears, the number of the band appears on the image, and the band's data is 
added to the Markers section of the data box. The horizontal red line remains, indicating that the cursor is 
ready to select the next band as described above. 

After entering the value for the last marker, click the Add Markers Complete button instead of OK. This will 
deactivate the value-entering function and will return the cursor to its normal mode. (To reactivate the value-
entering function, select Add Marker from the menu again, or click the right mouse button.)

The Molecular Weight Data Box

The data box is located near the top of the image. Initially, no values are displayed in the data box. When a 
molecular weight value is assigned to a band, the following information is displayed in the data box:

• Band numbers are assigned beginning with the first band, continuing in the order selected.

• The position corresponds to the band's location along the y-axis, ranging from 0 to 1030.

• The value displayed under the Molecular Weight. heading is the molecular weight value entered for a 
known and or the value calculated for an unknown band.

• The Rf value for each band is also displayed. Unless otherwise specified, AlphaView assumes the origin 
(Rf value = 0.00) is located at the top of the screen, and dye front (Rf value = 1.00) is at the bottom of 
the screen. Using these points as a frame of reference, AlphaView calculates Rf values for the interme-
diate bands.
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Figure 5-4: Molecular Weight Marker and Query Data

If the data box obscures part of the image, it can be resized or moved using Windows® functions, or it can be 
hidden using the Hide Data checkbox.

Repositioning and Deleting Markers

Marker band indicators can be repositioned simply by positioning the cursor, clicking, and dragging the line to 
the desired location.

To delete a molecular weight marker, point the cursor at the appropriate marker band and click the left 
mouse button. This highlights the band in question by putting a red box around it.   (Alternatively, clicking in 
the data table highlights the marker’s information and selects the band on the image.)

Click on the Delete Marker function in the Marker menu. The marker is deleted, as is the band's data in the 
marker data table. Markers entered after the deleted bands are renumbered on the image and the data table.

To delete all the markers and start over, select the Clear Markers function in the Marker menu. 

Determining Molecular Weights of Unknown Bands

After marker values are entered, the molecular weight of any unknown band can be determined.
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Manually Selecting Bands

To indicate unknown bands manually, select the Add Band function from the Query menu. Just as in Add 
Marker above, a line will appear attached to the cursor. Point the cursor at the band of interest and click the 
mouse button. The molecular weight of the band is automatically calculated and displayed in the Queries 
section of the data box. 

To select a second band, click the right mouse button and the cursor line will reappear. Repeat this procedure 
for all bands for which molecular weights is to be determined. 

NOTE: The molecular weight markers appear in blue while the queries appear in green. 

The molecular weight of a band is calculated based on the graph of the known marker bands. 

NOTE: If a query band lies outside of the markers, it will be extrapolated in “Least Squares Fit” mode or 
given a value of “N/A” in “Point-to-Point” mode. For more information, see “The Graph Tool” on page 106.

Automatic Band Finding

AlphaView includes an algorithm for automatically finding bands in query lanes. To use this function, select 
Auto Query from the Query menu. A yellow vertical line will appear attached to the cursor. Position the line 
over the lane of interest and click the left mouse button. The bands in the lanes will be selected automatically, 
and their data will appear in the Data box. 

Repositioning and Deleting Bands

Bands can be repositioned simply by positioning the cursor, clicking, and dragging the band to the desired 
location.

To delete an unknown band indicator, point the cursor at the band and click the left mouse button. The band 
in question is highlighted. (Alternatively, clicking in the data table highlights the band’s information and selects it 
on the image.)

Click on the Delete Band function in the Query menu. The band will be deleted, as will the band's data in the 
query data table. Bands entered after the one deleted are renumbered on the image and the data table.

To delete all the queried bands, select the Clear Queries function in the Query menu.
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Using the Molecular Weight Standards Library

AlphaView contains a library of DNA and protein molecular weight standards. Additional sets of markers can 
also be added to this library for later access. For a complete list of pre-loaded files and the band sizes in each, 
see Appendix B, “AlphaView Molecular Weight Library Files“.

Applying a Set of Saved Markers

From the Marker menu in the data box, select Get Markers from File. A dialog box appears.

 

Figure 5-5: Get Markers from the Open Molecular Weight File Dialog Box

Using the left mouse button, click on the name of the file to be loaded. That name is then highlighted in the 
list and appears in the text box below the File Name: prompt. 

The current directory path is shown beneath the Folders heading. Below this is a graphical depiction of the 
path, and the sub-directories of the current directory. If the file of interest is in a different directory than the 
one open, double-click on the appropriate folder icon.

Once the file has been selected, click on the OK button to load the file. (Alternatively, double-click on the file 
name.) The dialog box disappears and a new dialog box appears.
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Figure 5-6: Load Markers Auto Load Dialog Box

This box gives the file name selected, as well as the number of markers contained within the file. It also give 
the user the option of auto-loading the file.

• If Yes is selected, a vertical line will appear attached to the cursor. Place the vertical line in the marker 
lane on the gel, and click. AlphaView will automatically search for the markers in the lane. In the above 
example, the brightest 7 bands in the lane would be selected, and the values for Boe II’s 100 bp DNA 
marker ladder would be assigned to the bands.

• If No is selected, AlphaView will display a cursor with a red line attached. Text in the upper right-hand 
corner of the image window will tell the user how many markers have been entered, and the value of 
the next marker to be entered.

Figure 5-7: Manual Load Dialog

To begin entering markers, move the cursor to the top band in the lane and align the horizontal line with the 
band. Click the left mouse button. Notice that the position for that band is added to the markers data table.

Move the cursor to the next band, click the left mouse button again to assign the next value in the series. 
Repeat this process until the values of all the marker bands are assigned.

To quit this function before all markers have been placed, click the right mouse button.

Adding a Set of Molecular Weight Markers to the Library

If the same set of molecular weight markers will be run repeatedly, there is no need to enter values on each 
new image. Instead, save the molecular weight values in a file and apply them to the marker lane of any 
subsequent images.

To save a set of molecular weight standards, click on Write Markers to File in the Marker menu after the 
marker values have been entered. 
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Following Windows conventions (255 characters or less), enter a new file name in the text box below the File 
Name: prompt. AlphaView will automatically give the appropriate 3-character extension.

The current directory path is shown beneath the Directories heading. Below this is a graphical depiction of 
the path, and the sub-directories of the current directory. If the file is to be saved in a different directory than 
the one open, double-click on the appropriate folder icon.

Alternate disk drives can be accessed using the Drives heading.

Once a name has been entered and the appropriate directory has been accessed, click OK. All of the marker 
values that are currently in the Data window will be saved to this new file. To access them in the future, follow 
the steps in “Applying a Set of Saved Markers” on page 103.

Special Functions 

Snap to Peak

This feature makes it easier to place the cursor on a band. If the Snap to Peak function has been activated, 
the cursor jumps to the highest pixel value in the band as the cursor approaches it. 

If bands are so tightly spaced that the line is not coinciding with the band, turn off Snap to Peak and place 
the marker on the band manually.

If the cursor is jumping to areas between bands instead of the bands themselves, check to see that the Bands 
Darker than Background checkbox is properly set.

Calculating Rf Values

To obtain accurate Rf values, specify the location of the wells (i.e., origin) and the dye front using the functions 
Set Well Pos./Start and Set Dye Front/End both found in the Marker menu. 

To designate the location of the wells, point the cursor at Set Well Pos./Start. Position the cursor so it is point-
ing anywhere along the wells and click the left mouse button. A horizontal bar appears, defining the location 
of the origin. By clicking and dragging, the bar can be moved for better positioning.

Repeat this procedure using Set Dye Front/End to indicate the location of the dye front.

Once the origin and dye front have been defined, they are used to calculate the Rf values of any bands that 
are added. If dye fronts are not assigned, AlphaView uses the top and bottom of the image as the boundaries 
for calculating Rf values.
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The Molecular Weight Cursor Box

Figure 5-8: Molecular Weight Cursor Box

The Molecular Weight Cursor box, found in the Molecular Weight toolbox, reports the location on the 
y-axis, the molecular weight and the Rf value of the current position of the cursor. These data are updated as 
the cursor is moved. This information can be helpful for positioning the cursor in a precise location, or for a 
quick estimate of a band’s size.

The Graph Tool

The Graph function is found in the lower left corner of the Molecular Weight tools box. 

Figure 5-9: Molecular Weight Tools
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Clicking in the Graph box displays the semi-log graph of the molecular weight data that is used to calculate 
the molecular weights of unknown bands. (To remove the graph window from the display, click on the Graph 
checkbox a second time.) The x-axis corresponds to the band's vertical location on the screen, and the y-axis 
is a log representation of molecular weight. By clicking on the appropriate button, the data can be toggled 
between a least squares fit and a point-to-point fit.

Figure 5-10: Example of Point-to-Point and Least Squares Fit Graph

The graph is useful to verify that the molecular weight data is entered correctly, and can help determine the 
most linear region of the molecular weight standards. Further, if a query band is clicked, its position will be 
shown on the graph by dashed lines (in Figure 5-10). 

Colony Count
The Colony Count tools in the Tool Box, Analysis Tools make it easy to count the number of objects on an 
image, such as colonies on a Petri dish or viral plaques.

Click on Colony Count. The following sets of tools will be displayed in the lower left of the screen.
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Figure 5-11: Colony Count Tools

Figure 5-12: Sample with Two Types of Objects

When two types of objects are counted, the objects are highlighted in different colors. They can also be 
marked on the image using a “+” or an “X”.

Follow these three steps to perform an automatic colony count:

1. Define and Position Area(s) of Interest
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There are three drawing tools with which areas of interest can be designated. Click on the desired AOI (Area 
of Interest) button in the toolbox to define areas on the image containing the objects to be counted.

Figure 5-13: Colony Count Tools

Circles: This is the most appropriate choice for counting colonies on a Petri dish. After clicking on the button 
in the toolbox labeled with a circle, move the cursor into the image area to the edge of the Petri dish. Click 
the left mouse button and move the cursor to open the circle. When the circle corresponds to the perimeter 
of the Petri dish, release the mouse. The circle has “handles” around it, and can be moved or re-sized at this 
point. 

Hint: To draw a perfect circle around a portion of an image, first visualize a square surrounding the area of 
interest. Position the mouse in the upper left hand corner of the square. Click and drag the mouse down 
across the area of interest at a 45° angle until the circle encloses the area of interest.

Rectangles: After clicking on the button in the toolbox labeled with a square, move to one of the four corners 
of the region to be enclosed. Click the left mouse button and move the cursor to the corner diagonally oppo-
site. 
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NOTE: The box that opens as the cursor moves. Release the left mouse button when the box has reached 
the desired size. The rectangle has “handles” around it, and can be moved or re-sized at this point.

Freehand Drawings: To draw a freehand object, select the freehand icon; the mouse will change to a pencil. 
Draw an object of the desired size and shape. When the mouse is released, the start and end points of the 
object will be connected.

Manipulating Areas of Interest: Areas of interest can be moved, copied and deleted. To perform any of these 
functions, an area must first be selected by clicking on it or dragging the cursor around it. Its color changes to 
gray, indicating that it is active. More than one area of interest can be selected at any given time.

To move an area of interest click on the selected area. While holding down the left mouse button, drag the 
area to the desired location.

To delete an area of interest click on the cut button in the toolbox (designated by a pair of scissors). The 
selected area of interest is removed and any other areas of interest are renumbered accordingly.

To copy a selected area of interest, click on the copy button (found next to the cut button). A second copy of 
the area of interest appears overlapping the first one. Click and drag the copy to the desired location.

2. Set the Density Thresholds

The objects counted by the automatic counting routine are based on the difference in the gray levels of the 
objects as compared to the background (e.g., the colonies on the petri dish are either darker or lighter than 
the surrounding area). The density thresholds define the gray levels that are recognized by the counting 
routine.

To set the density threshold, click and drag the sliders. As the sliders are moved, the regions of the image that 
fall within the gray scale range are highlighted in the image area. Adjust the slider positions until the objects to 
be counted are highlighted. The numbers next to the Min and Max settings change to reflect the positions of 
the sliders. These numbers represent the minimum and maximum gray scale values that are currently being 
detected. Any object whose gray level falls between these two numbers will be counted.

If there are two sets of objects to count, click on the second colony count button (next to the Count button) 
and adjust the density threshold so the second set of objects are highlighted.

3. Count the Objects

When the density threshold settings and size settings are satisfactory, click on the Count button. If two types 
of objects are to be counted, click the second colony count button and click Count again. The counts are 
shown for each area of interest and the totals are given in an colony count display window on the image.
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Figure 5-14: Colony Count Sample Results for an AOI

Editing Tools

After the objects have been automatically counted, AlphaView will automatically open the Edit Tools 
functions. If editing is necessary, these tools manually override decisions made by the automatic counter.

Figure 5-15: Colony Count Editing Tools

Displaying Spots

Spots are displayed as red (or green) numbers on the image. These can be changed to symbols (“+” or “x”) 
by holding the <shift> key and clicking the right mouse button. Repeat to return to numbers.

Spots can be hidden from view by checking the Hide Spots checkbox.
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Specify the Size Range of the Objects

If the image has objects of different sizes but only those in a certain size range are of interest, use the Area 
Controls. 

Specify the size range by adjusting the minimum and maximum diameter settings. The numbers below the 
Min. Area and Max. Area headings indicate the minimum and maximum diameter settings in pixels. Any object 
whose diameter falls between these two numbers will be counted. 

As these number are changed, objects will be added to (or deleted from) the display, and the Count windows 
will be updated.

Using the Add Spot Tool

Occasionally, the automatic counting function may fail to count an object on the image. This could occur for a 
variety of reasons, including inappropriate Density and Size Threshold parameter settings. 

Objects can be added to the total count numbers using the Add Spot button. Click on the appropriate count 
box (red or green). Next, click on the Add Spot button. Point the cursor at the object to be added and click 
the left mouse button. The object will be highlighted and the count will automatically increase. 

Figure 5-16: Results of Colony Count After Manual Addition of Three Spots

To add a second object, click on the right mouse button to re-enter “add” mode, then click on the desired 
object with the left mouse button.

Using the Erase Spot Tool

This function removes any extra spots that were counted either automatically or manually. For example, if a 
portion of an AOI has high background or other noise, a number of objects may erroneously be included in 
the count. Draw a box around the object or set of objects. Objects will be displayed with a white background 
to indicate that they are selected. Clicking Erase Spot deletes all selected objects at once and automatically 
reduces the total count information. 
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Spot Count Data

When AlphaView opens, the Colony Count data box is hidden. To display spot count data, click the checkbox 
to deselect Hide Data. The following data window will appear:

Figure 5-17: Colony Count Data Window Showing AOI Summary Data

This window shows the summary data for the Area(s) of interest (AZ). This includes the threshold values that 
were set for each count type, the number of objects found for each count type, and the total pixels in all of 
the spots.

To see specific details on each spot, click View > Spot Details. Figure 5-18 displays an example of what 
displays: 

Figure 5-18: Selecting the Colony Count Data Window to Show Individual Spot Details

The data table gives the individual spot number, the AOI in which it was counted, its coordinates, the 
integrated density value (IDV) for each spot, the area (number of pixels) for each spot, and the % contribution 
to the total. 
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NOTE: Manually-added spots show areas of 1 pixel.

Band Analysis Tools
In the ToolBox, Analysis Tools, a tab labeled Band Analysis opens a set of tools with which the density of 
bands, spots or other objects can be measured. A two dimensional area of interest (or Object) is created and 
the density is obtained through the corresponding pixel intensity values designated as IDV or Integrated Den-
sity Value. 

Figure 5-19: Band Analysis Object Tab

Creating an Object Area of Interest 

Object Boxes: 

An area of interest can be created in several ways. The user can manually draw an area of interest through the 
three OBJECT buttons. Objects can be enclosed with a box (rectangle), ellipse, or freehand drawing. Select 
the one that most closely corresponds to the shape of the objects on the image. 
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To draw a rectangle or ellipse, click on the button labeled with a box (or a circle) beneath the OBJECT header 
in the toolbox. The cursor automatically changes to a “+” when it is in the image area, indicating that 
AlphaView is in “drawing” mode. Move the “+” to the corner of the object to be measured, click the left 
mouse button, move the cursor, and release the mouse button when the box (or circle) surrounds the object. 

Hint: To draw a perfect circle around a portion of an image, first visualize a square surrounding the area of 
interest. Position the mouse in the upper left hand corner of the square. Click and drag the mouse down 
across the area of interest at a 45° angle until the circle encloses the area of interest.

 

To draw a freehand object, select the freehand icon; the mouse will change to a pencil. Draw an object of the 
desired size and shape. When the mouse is released, the start and end points of the object will be connected.

Once the mouse is released, the cursor changes to an arrow (indicating that AlphaView is in “edit” mode), 
and the object is shown in gray with handles around it. The object can now be resized using the handles or 
repositioned by clicking within the boundaries and dragging to a new location.

To draw another object, return AlphaView to “drawing” mode by clicking the right mouse button.

If a box or ellipse is large and includes significant background area, the corresponding density value may be 
large. The higher the background, the greater its contribution to the total of pixel values in that object. There-
fore, objects should be drawn so that they fully enclose areas of interest, but do not include an excessive 
number of background pixels or pixels from neighboring regions:

Figure 5-20: Drawing Objects Examples

Hint: Keeping the data window open can reduce the speed at which objects are drawn and manipulated 
on the screen. Therefore, it may be preferable to hide the data window until all objects and backgrounds 
are drawn and in place.
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Hint: Accurate Local Background Correction method requires the object box to contain a few pixel values 
that are true representations of the background level. If the object is too small and the band fills the object 
box then local background correction will result in significant errors.

Magic Wand and AutoSpot

These two selections are automated detection features designed to recognize sample in an image and draw 
Object boxes around it. They are found under the Auto Detect heading in the main Multiplex Band Analysis. 
Tab. Once an object is created the dimensions can be altered and the background subtracted similar to 
manually drawn objects.

Figure 5-21: Magic Wand and AutoSpot Tools

Magic Wand

Selecting Magic Wand will activate a wand like symbol and the following data table:

Figure 5-22: Magic Wand Parameter Window
AlphaImager HP, EP and EC User Guide



Band Analysis Tools page 117
The tip of the wand should be centrally positioned over the sample spot on the image and then simply click 
the mouse. The software will use either an “edge detection” algorithm to trace an area of interest around the 
spot or draw a box around the sample. A right mouse click will reactivate the wand icon for another selec-
tion.

Magic Wand Sensitivity

The Magic Wand Sensitivity slide bar will alter the parameter for how much of the spot will be detected. The 
slide bar ranges from 0 to 100. The smaller the number the less of the spot the software will define. The 
greater the sensitivity number the more of the object the software will find.

HINT: Selecting a brighter pixel within the band (or spot) will have magic wand draw a tighter area of inter-
est. Correspondingly, a less intense pixel will draw a larger perimeter around the selected spot.

Spot Type

Under the Spot Type heading the Bright Spots selection should be checked if the image contains bright spots 
on a dark background (e.g. ethidium bromide stained fluorescent gels and chemiluminescent blots). The Dark 
Spots selection should be made when the sample contains dark sample on a light background (example: film, 
Coomassie blue protein gels). The software should automatically determine this selection, but some manual 
intervention may be necessary. Remember as in all portions of AlphaView software if the image has been 
reversed (negative image) using the Reverse selection on the Contrast Adjustment window the Dark Spot 
selection should not be made. Reverse is a visual alteration only and does not affect the original image capture 
data. (e.g. a chemiluminescent blot is captured using the Reverse mode in order for it to appear as film, the 
correct selection is still Bright Spots).

Outline Type

Border Outline will use the edge detection methods to determine the spot area. Box Outline is the default 
setting and will draw a box shape around the sample usually including a significant portion of background. 
User preference and image particulars will determine which outline type is best.
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Previous Location

Previous Location will automatically select the spot on the image last selected for magic wand and apply any 
changes made for sensitivity. This feature is designed to quickly evaluate how the different sensitivity numbers 
will affect the drawn area using the same selected point in a spot. The X,Y coordinates are given for the 
previous spot as well. 

Exit

Exit will remove the Magic Wand Parameter window. 

Auto Spot

Auto Spot is a feature designed to find multiple spots within a region of interest. It is accessed through 
AutoSpot under Auto Detect in the Multiplex Band Analysis tab. Once it is selected the following tab will 
appear and the cursor will be ready to draw an area of interest.

Figure 5-23: Auto Spot

Area of Interest

After selecting AutoSpot an area should be drawn on the image by clicking and dragging the mouse. The 
smaller and more defined the Area of Interest is, the better the resulting data.   The area can be manipulated 
using the manipulation tabs at the edge of the red box. 
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Options

The Options selection allows either a box outline to be drawn around the spots or a border outline. The box 
outline is the default setting and will include more of a background in the drawn area than the border outline. 
User preference and image particulars will determine which outline type is best for sensitivity can also be 
adjusted by sliding the bars for normal spots (<98% saturation) and for saturated spots (>98% saturation).

Figure 5-24: Auto Spot Options

Bright Spot vs Dark Spot

The Bright Spots selection should be checked if the image contains bright spots on a dark background (e.g. 
ethidium bromide stained fluorescent gels and chemiluminescent blots). The Dark Spots selection should be 
made when the sample contains dark sample on a light background (film, commassie blue protein gels etc.). 
The software should automatically determine this selection, but the user may have to override it if the 
software incorrectly evaluates an image. Remember as in all portions of AlphaView software if the image has 
been reversed (negative image) using the Reverse selection on the Contrast Adjustment window the Dark 
Spot selection should not be made. Reverse is a visual alteration only and does not effect the original image 
capture data. (EG if a chemiluminescent blot is captured using the Reverse mode in order for it to appear as 
film, the correct selection is still Bright Spots).

Find Spots

The Find Spot button is selected once the correct area of interest is drawn and the Bright Spot/Dark Spot 
selection is correctly made. A green outline will be drawn around the detected spots. 
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Background Threshold

The background threshold slide bar will adjust the criteria used for finding spots. It is on a scale of 0 to 100% 
saturation. The sliding bar maps the dynamic range of the camera. By calculating the fringe pixels in the image 
or ROI, the initial threshold value and suggested lower (or upper) bound value are calculated and shown on 
the sliding bar. The user can always override the threshold value by moving the sliding bar or typing in the 
counter box.

Target Size

The user can input the minimum and maximum area in pixels of the spots or bands of the desired targets. The 
default values are 1 pixel minimum and no limit for maximum pixels.

Get Data

Get Data is selected once a satisfactory spot outline is achieved. This will convert all drawn objects into 
standard Spot Densitometry objects with associated density numbers.

Manipulating Objects

Selecting Objects

To select an object, click on it with the mouse. “Handles” will appear at its corners.

Figure 5-25: Non-Selected and Selected Objects

To select a second object instead of the first, click on the desired object.

To select more than one object at a time, drag the mouse around all of the objects of interest. 

NOTE: An object must be completely surrounded by the mouse operation in order to be selected.

To select more than one object where it is not feasible to drag the mouse around objects, hold the <shift> 
key and click on each object to be selected.
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To de-select an object, click the left mouse button outside of the selected object. The handles disappear, 
indicating that the object is no longer selected.

Copying Objects

To draw boxes or ellipses enclosing the same number of data points, use the Copy function. 

First, draw or select an object of the desired shape and size as described above. Next, click on the Copy but-
ton in the toolbox. A duplicate of the selected object will appear on the screen. This object can then be 
moved to the desired position. 

To make multiple copies of an object, continue to click on the Copy button until the desired number of copies 
is displayed.

Moving Objects

An object can be moved to fine-tune its position simply by clicking on it, holding down the left mouse button 
and dragging it to the desired location.

Deleting Objects

To remove an object or set of objects, select the object(s). Select the Delete button on keyboard. All the 
selected objects are removed from the image window and their associated data is cleared from the data 
window.

Band Analysis Measurements

As objects are drawn, their density data is automatically calculated and displayed in a data window. Any time 
an object is drawn or detected, the data in the window are updated. If the Band Analysis Results window 
obscures a region of interest, resize and/or move it following Windows conventions.
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Figure 5-26: Example of a Multiplex Band Analysis Data Window

Data Definitions
Please refer to Appendix C, “Data Description Tables“ for a complete listing and description of the various 
quantities.

# is the number assigned to each object on the image in the order in which they were drawn. This object 
number is also shown in the corner of the object.

IDV is the sum of all the pixel values after background correction:

IDV = Σ(each pixel value - BACK)

% is the percentage that each box, ellipse, or freehand drawing contributes to the total density measured thus 
far, taking background correction into consideration. The sum of the values in this column will be 100.

Area is the size (in pixels) of the region enclosed by the box, ellipse, or freehand drawing.

Average is the average value (after background correction) of the pixels enclosed.

AVG = IDV ÷ AREA

Background is the background value that will be subtracted from all the pixels in the object. (See “Back-
ground Tab–Calculating Background Values” on page 123 for more information.)

Inverting Data

The Invert function reverses the gray scale assignments so that 0 corresponds to white and 4,095 
corresponds to black. This control is found on the Region tab.

If the image has dark bands and light background, then Invert should be selected by placing an “X” in its box. 
If the image has light bands and dark background, the Invert option should not be activated.
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NOTE: This function does not alter the appearance of the image (unlike the Reverse button described in 
Chapter 2, “Getting Started—Basic Imaging Functions“).

Background Tab–Calculating Background Values

Background subtraction is an important part of image densitometry analysis. There are three background sub-
traction options in the Band Analysis tools.

IDV = Σ(each pixel value - BACK)

Figure 5-27: Background Tab

No Background

If no background calculation method has been selected, the background value in the data window (BACK) is 
reported as zero (0). Therefore, the object’s integrated density value will be equal to the sum of all the pixel 
values within the box, ellipse, or freehand drawing. Recommendation: No Background or Manual Background 
is suggested for AutoSpot, Magic Wand (only the border outlines though) or any object where little if any 
background is included in the object area of interest. 
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Automatic Background

When the Auto Background function is active (an “X” appears in the checkbox), AlphaView determines the 
average of the 10 lowest pixel values in each individual object and assigns that value to BACK. This option is 
useful if the image has regions with different background levels, because the background values (BACK) will be 
unique for each object.

NOTE: If Auto Background is active, it will override the manual background option (described below).

Manual Background

Using this option, different region(s) of the image representative of different background densities can be 
specified. Further, the user can specify exactly which objects of interest should correspond to which back-
ground objects.

To manually specify the background, use the buttons beneath the Background heading in the Band Analysis 
toolbox to draw a box (or ellipse or freehand drawing) around an area representative of background density. 
If the background varies across an image, draw several background objects in order to represent each of the 
various background levels.

Next, specify the object(s) from which each background density should be subtracted. To associate a back-
ground with an object(s), select the object(s) and the background as described in “Selecting Objects” on 
page 120. When all are selected, click on the LINK BCKGRD button in the Band Analysis toolbox. All the 
objects will assume the color of the background object, indicating that they are associated with each other. 

Figure 5-28: Using Manual Background to Assign Different Background Values to Different Objects: Objects 1-5 are linked to 
B1; 6-7 to B2; 8-9 to B3

In the Band Analysis data window, these objects now show a non-zero background density value in the BACK 
column. 
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To disassociate an object from its background, select the object and click on the Unlink Bckgrd button. The 
object reverts to its original color, indicating that it is no longer associated with any background box or ellipse. 
The object's value in the data window changes and its entry in the BACK column returns to zero.

Note: If Auto Background is active, manual background settings will be overridden.

Mass Standard Calibration Curves for Quantitative PCR

The button in the Band Analysis toolbox labeled Std Curve opens a set of tools that create a calibration curve 
for applications such as quantitative PCR. The calibration curve functions allow quantization of the bands on a 
gel based on a set of standards. A minimum of two standard bands must be input, but the accuracy of the cal-
ibration curve increases as the number of standard bands and their range of values increase.

Defining the Bands as Objects

Before generating a standard curve, define the bands using the object drawing tools in the Band Analysis tool-
box. As described in “Selecting Objects” on page 120, the size of an object can influence the integrated den-
sity value. Therefore, we recommend using the same sized box, ellipse or freehand drawing when defining a 
standard curve. (For instructions, see “Copying Objects” on page 121.)

Specifying the Quantization Units

Once the objects are defined, click on the Std Curve button. The Standard Curve Toolbox will appear in 
which the results should be reported (e.g. ng, μL, pg, %) in the Enter units box
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Figure 5-29: Standard Curve Tab

Designating the Standard Bands

Click on one of the bands whose value is known. In the dialog box displayed, enter the value for the band, 
using either the keyboard or the numeric keypad in the dialog box. When the entry is correct click on the OK 
button. The band number changes from white to green, indicating that it is now a standard.

To enter the next value, click on another band. The dialog box will open again and will show an estimated 
value (based on the object’s IDV value and on the standard value already entered). Click OK to accept this 
value, or enter a value.

Figure 5-30: Entering the Value for a Standard Band
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Once the second value has been entered, a curve is displayed. The points corresponding to the standard 
bands are labeled in yellow. Points for the unknown objects on the image are displayed on the standard curve 
based on their integrated density values. These are labeled in white.

Figure 5-31: Standard Curve

Enter values for each band whose amount is known. As more standard points are added, the calculated values 
of the unknown points may change. 

To remove a band from the set of standards, click on it again. The band number changes from green back to 
white, indicating that it is no longer a standard. To de-select all the standard points at once, click on the 
CLEAR STD PTS button in the toolbox.

To change the value of a standard band, click on it twice. In the dialog box, the estimated value for that band 
is displayed. Accept this value by clicking OK, or enter a new value.

Displaying the Curve

If the box displaying the standard curve obscures a part of the image, it can be resized using Windows oper-
ating system functions. It can be hidden from view by clicking the HIDE CURVE checkbox in the Standard 
Curve toolbox. 

Quantization Values of Unknown Bands

As the values for the standard bands have been entered, the quantitation values of the unknown bands are 
automatically calculated. To see the calculated values of the unknowns, click on the EXIT button in the stan-
dard curve toolbox. This returns to the Band Analysis tools and data box. 
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Note: The graph is based on a Smoothed Cubic Spline fit. To use other curve-fitting methods, exports the 
data table as an ASCII file and open it in any statistical analysis package.

Figure 5-32: Band Analysis Data Box

The third column in the data box contains values for the standards (entered by the user), and the values for 
the unknown bands (calculated based on the curve). The heading of this column reflects the units entered as 
in “Specifying the Quantization Units” on page 125

An “n” next to the object number indicates that the objects are unknowns (or non-standards) whose value 
has been interpolated. An “a” means that the object lies outside of the curve, and its value has been approxi-
mated through extrapolation. Standards have an “s” next to the object number, and are highlighted in green 
to differentiate them from unknown bands.

Lane Profile
The Lane Profile option in the Analysis Tools tab of the ToolBox accesses a set of densitometry and 
molecular weight determination tools with which bands on a gel can be automatically analyzed in a lane for-
mat. 

When Lane Profile is selected, the Lanes tab is displayed with the following functions:
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Figure 5-33: Lane Profile Lanes Tab

Profile Path Width 

The Profile Path Width is the area from which the pixel density is measured. The default setting is 10. To 
adjust the setting, click on the up or down arrows or enter a value and hit the enter button on the keyboard. 

The density values for Lane Profile graphs are determined by the average pixel density between the blue lines 
on the template. 

A Profile Path Width that is too narrow may not include enough information and can result in a noisy 
graph. By contrast, a Profile Path Width that is too wide can incorporate background pixels that will 
reduce the pixel average and dilute the actual data.

Auto Lane Detection Using an Area of Interest

AlphaView can automatically detect and analyze the lanes and bands in the area of interest specified by the 
user. To draw an area of interest, click and hold the mouse and draw a box around the sample area of interest. 
Image artifacts (well position marks, etc.) should not be included in the box as AlphaView may record them 
as bands. After an area of interest is drawn, click on the Detect Bands button in the Lanes tab. AlphaView 
will automatically detect the lanes and analyze the bands in the area of interest. 
AlphaImager HP, EP and EC User Guide



page 130 Chapter 5: Image Analysis Tools
Figure 5-34: Area of Interest Drawn

Manual Lane Detection

Select the Manual Lanes checkbox to manually detect the lanes on the image. Once selected, the Auto 
Grid template will appear on the image. 

Figure 5-35: Lane Profile Auto Grid Template
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Setting Up the Lane Profile Template

Red lines in the Auto Grid template indicate borders of adjacent lanes. Green lines define the Profile Path 
Width. 

Manual Lanes Box
Select the Number of Lanes up to a maximum of 24 lanes. When the number of lanes is adjusted, the 
template displayed on the image is updated accordingly. 

If the lanes on the gel are horizontally oriented (sideways) the image can be rotated. To change the orienta-
tion of the image to coincide with the template, click on the Enhancement Tools tab in the Toolbox and 
select the Rotate-Flip option. Click and drag the rotation bar +/- 90 degrees until the desired orientation is 
reached.

After specifying the correct number of lanes and changing the image orientation, adjust the outside borders of 
the template until they frame the lanes to be scanned. To do this, first click on the template. Next, select any 
of the blue boxes along the outside border of the template and drag it until the desired size is reached. Adjust 
the template until the border of the template frames the lanes to be scanned and the red lines lie between 
each of the lanes.

If the lanes of the gel are not perfectly straight, click the Skewing checkbox in the Manual Lanes box. The 
template will display four blue boxes, one at each corner of the template. Click and drag the blue boxes as 
needed until the template is positioned properly over the skewed lanes.

Figure 5-36: Skewed Lane Profile Template Properly Aligned on a Gel

Profile Path Width
Adjust the Profile Path Width value as needed. The path width should not exceed the band edges and cannot 
extend beyond the red lane borders. As this value is changed, the template displayed on the image updates 
accordingly. 
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Bands Darker than Background Option

Select the Bands darker than background checkbox if the image being analyzed has dark bands/signal on 
a white background which are usually colorimetric gels. The Bands darker than background option is 
only necessary when the actual sample has signals that are visible by the naked eye, for example Coomassie 
Blue stained gels, Silver stained gels, and pieces of autorad film.

Image Analysis–Detect Bands

Select the Detect Bands button to automatically measure and calculate the densities of each lane. To have 
AlphaView detect all bands in the image automatically select Detect Bands immediately after opening an 
image. Otherwise, select Detect Bands after drawing an area of interest or after the Manual Lane settings 
and template have been adjusted. 

Viewing Results

Once the Detect Bands button is selected, AlphaView automatically analyzes the image, detects the peaks 
for each lane, integrates the area under each peak, displays results and moves to the Bands tab. 

Figure 5-37: Lane Profile Bands Tab

Peak integration adjustments that can be made manually will be described in detail later in this section. The 
Analyzed Image and the Lane Profile Results windows are displayed. 
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Analyzed Image

Individual bands will be identified by number on the analyzed image. When a lane is selected in the image its 
borders will turn pink. The corresponding lane data will be displayed in the Lane Profile Results windows.

Figure 5-38: Analyzed Image

Lane Profile Results Windows

The following results windows will also be displayed after the image is analyzed. These windows can be 
resized or docked by the user if desired: 

• Data Table (middle). The Data Table displays peak information for each lane in the image. 

• Lane Graphs (lower left). This area displays a graph for each lane. 

• Active Graph (lower right). The active graph displays peak numbers and integration data for the lane 
selected.

To view data and the Active Graph for a lane, select a lane either from Analyzed Image or from the Lane 
Graphs. To view peak data for a specific band, select the band in the Analyzed Image or the peak from the 
Active Graph. The corresponding data will be highlighted in the Data Table. AlphaView uses the following 
color-coding to indicate what data is being displayed:

• The lane graph that is currently selected will be grey. 

• The data for the currently selected lane will be highlighted in yellow in the Data Table. 

• The data for the currently selected band or peak will be highlighted in dark yellow in the Data Table, 
and the peak fill in the Active Graph will also be dark yellow.
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Figure 5-39: Results showing Color Coding in Data Table (top), Lane Graph (lower left) and Active Graph (lower right)

Lane Graph Display
Graphs representing all Analyzed Image lanes are shown in this area. After band detection, Lane 1 will be 
selected by default and its corresponding peak data will also be displayed in the Data Table and Active Graph. 
To view data for a different lane simply click on its lane graph. 

When the image contains many lanes, there may be too many graphs in the Lane Graph display to see rea-
sonable detail. To reduce this view to only four lane graphs, select the Options menu directly above the Data 
Table and deselect Show All Lanes.

Figure 5-40: Deselecting Show All Lanes
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Active Graph
The Active Graph is shown in the lower right. The x-axis represents the distance (in pixels) from the top of 
the area of interest drawn or the Auto Grid template used. The y-axis represents the average pixel intensity 
across the width of the scan. 

NOTE: Active Graphs are shown without axes in order to show as much detail as possible in a small win-
dow. To show the graph’s axes, choose Show Axes from the Show Single Lanes option in the Options 
menu located above the Data Table. 

Data Table
Once a peak is defined, its integration data and associated information are displayed in the Data Table. The 
data table is updated automatically when peaks are added or deleted, when peak boundaries are redefined, or 
if the background value is reset.

Figure 5-41: Example Data Table

The Data Table contains the following columns of data:

• LANE indicates the lane number where the peak is located. 

• PEAK is the number assigned to each peak on the graph. 

• DISTANCE is the migration distance (in pixels) for each peak as measured from the top of the 
region used for data analysis.

• WIDTH and HEIGHT are the calculated peak width and peak height.

• AREA is the integrated pixel intensity for the area under each peak and can be used to represent 
band intensity.
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• % is the percentage each peak contributes to the total density. The sum of this column will be 100% 
for each lane.

Lane Profile Results Menu

The drop down selections at the top of the Data Table (Data, Baseline and Options) allow for the user to 
perform editing, visualization and outputting tasks pertaining to the Active Graph window.

Figure 5-42: Visualization of the Active Graph

Data
The Data drop down menu allows the user to superimpose different lanes onto the Active Window using 
the Overlay Control selection. For detailed instructions, see “Overlaying Graphs” on page 141. Print will 
allow the user to print any or all of the profile and data table windows. Clipboard will allow the user to send 
any or all of the profile and data table windows to the clipboard for pasting into different programs (e.g. 
Excel). 

Baseline
Baseline manipulation and background subtraction can be performed using this menu. For detailed instruc-
tions, see “Adjusting the Baseline” on page 138. 

NOTE: Background subtraction can have a dramatic effect on how many peaks are recognized as bands. 
Try changing the background subtraction to optimize band recognition.    

Options
Selecting Show Data will display the Data Table. Selecting Show Single Lane will display the Acitve Graph. 
Selecting Show All Lanes will display the Lane Graphs. From the Show Single Lane menu option, Back-
ground Color allows the user to select a variety of different background colors for the Active Graph. Show 
Axes allows the user to display the axes on the graph. Show Image Strip will display a strip of the lane 
being currently analyzed. 
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Figure 5-43: Options > Show Single Lane Menu

Editing Peaks

Editing Peak Boundaries
The boundaries of existing peaks can be readjusted to make the peaks wider or narrower. To adjust either 
peak boundary, click on the peak to select it. Next, point the cursor at the vertical boundary line, hold down 
the left mouse button and drag the line to the desired location. When it is in place, release the mouse button. 

The data table is automatically updated to reflect any adjustments. Both the peak and the data in the data 
table will be blue to indicate that this is a user-defined (vs. automatically detected) peak.

Visualizing Peak Placements
To determine exactly where a peak is located relative to the original image, it is often helpful to see the graph 
and the gel image in the same orientation. The Show Strip function (found in the Options menu) displays the 
area of the gel that has been defined as a lane across the length of the x-axis.

Figure 5-44: Graph With Show Strip Selected

NOTE: If Show Strip fails to show a portion of the image, check that the appropriate driver for the VGA 
card is selected. 
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Adjusting the Baseline

As a default, the baseline value is set to Auto Base. As the baseline is adjusted, the values for all peaks are 
updated to reflect the new baseline.

All of the following functions are found in the Baseline menu under Background Subtraction:

Auto Base
This method breaks the red line defining the left boundary of the lane into sixteen regions, and outputs 
sixteen points which reflect the average backgrounds across those sixteen regions. The user can manipulate 
the 16 points by clicking and dragging. The user may also designate more points than the 16 and manipulate 
those in the same fashion.

Intra-Lane
This method uses the lower of the two values at the edges of the lane along its travel as the background. If the 
section of the image is used is wider than the bands, then this is a very effective way of removing co-migrating 
material from your measurements. This method should only be used if the bands are completely enclosed. 
This is because when the edges of your lane area intersect any of your bands, band material will be consid-
ered as background, severely affecting your results.

Rubber Band
This method can be thought of as stretching a rubber band underneath the lane profile. This option does not 
work well if the values at the ends of the intensity profile are lower than the rest of the intensity pixels. We do 
not recommend this method for images with poorly separated bands.

Minimum Profile
This method takes the lowest value on the profile of each lane as the background for that lane. We do not 
recommend this method for lanes where the beginning or end of the lane is the lowest point as this is 
dependent on where the lane boundary was placed when it was defined. This can be hard to repeat between 
analysis of the same gel.

Valley to Valley
This method requires that you have performed band detection first. The background is taken as the line 
between the edges of the bands in the lane. You enter a value (see “Set Parameters” on page 139) of 
maximum slope in the accompanying entry box to avoid situations where the edge between overlapping 
bands, which is not at the background intensity, causes the background to climb too high.
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Rolling Disc
This method requires you to enter a parameter for the size of the disc (see “Set Parameters” on page 139) in 
the entry box. This option calculates the background as if a disc, with the radius you have entered, were 
rolling underneath the lane profile. The larger the radius of the disc, the less the background rises with the 
profile.

Set Parameters

Figure 5-45: Background Subtraction Parameters Dialog Box

This dialog box is used to change values for Rolling Disc and Valley to Valley background methods.

Base Lock
The Base Lock function will designate the active graph baseline for all of the lanes in the data table. To de-
select this option click on the Base Lock a second time. The check mark will disappear.

Horizontal Base
Activating the Horizontal Base function will move the baseline to the 0 position (no background). The base-
line can be moved vertically by clicking the baseline and dragging it upwards. 

Reset Base
Activating the Reset Base function will move the baseline to the 0 position (no background). Unlike Horizon-
tal Base the baseline cannot be moved. 

Base Subtract
This selection will subtract the current baseline from the intensity value line. Un-check Base Subtract to deac-
tivate this feature.

Interpreting Lane Profile Data

AlphaView provides a variety of tools to help interpret Lane Profile scan data. 
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V. Line
Typically, the peaks on a graph correspond to the bands in a lane. The V. Line tool located in the Lane Graph 
Display can help determine if the peaks on two different graphs represent bands at the same molecular 
weight position (i.e. the same distance from the top of the gel).

To compare peaks on different graphs, roll the mouse over the Lane Graphs. A vertical line which can be 
scrolled across the graphs will appear. The intensity value at the point where the V. Line crosses the graph 
will be displayed. 

Figure 5-46: V.Line Tool Intensity Display

Alternatively, the V. Line can also display hash marks which is a useful tool for comparing peak heights. To 
toggle between displaying intensity values and hash marks when using the V. Line, click the right mouse but-
ton.

Figure 5-47: V.Line Tool Hash Marks Display

NOTE: The hash marks are most useful when only four graphs are shown so that enough detail is dis-
played. To change the Lane Graph display, select the Options menu which is directly above the Data 
Table and deselect Show All Lanes.
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Overlaying Graphs
When comparing the bands in one lane with those in another it is often convenient to display the graphs so 
that one is superimposed over another. After clicking on a graph so that it is enlarged in the image area, select 
the Overlay Control function (from the Data menu) to display the Lane Overlay Control dialog box. In this 
dialog box, specify the lane(s) whose graph(s) should be superimposed and the color and line pattern in 
which they should be displayed. 

• The first column in the dialog box contains the numbers of the graphs which can be superimposed. 

• The second column reports whether or not the graph of a particular lane is currently superimposed. 
These ON/OFF settings toggle back and forth by clicking on them. 

• The colored bar in the third column indicates the color in which a graph will be displayed when it is 
superimposed. To select a color option, click on the color bar until the desired color is shown. 

• The last column in the dialog box specifies the pattern of the line when the graph is superimposed. To 
select a pattern, click on the current pattern until the desired pattern is shown. 

It is especially important to choose different patterns if the graphs will be printed, as differ-
ent colors cannot be distinguished using a gray scale printer.

When the selections have been made, click on the DONE button to dismiss the dialog box and superimpose 
the selected graph(s). (If no graphs have been selected, the dialog box is simply dismissed.) 

Figure 5-48: Three Graphs Overlaid

To turn all graph superimposing off, select the Deselect All button at the bottom of the dialog box.

Bands Tab Overview

Several lane editing and viewing options appear in the Bands tab. Each will be explained in detail in this sec-
tion.
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Figure 5-49: Lane Editing Features

Add Lane
This option allows an additional lane to be placed on the image. To add a lane, select the Add Lane button 
and place the mouse on the image. A plus sign cursor with a new lane grid will display on the image where 
lanes can be added. Roll the mouse over the image to move the cursor to the desired position. When the 
desired position is reached, click the mouse to drop the lane on the image. To add more lanes, move the cur-
sor to another position on the image and click to add the next new lane. Continue until all new lanes are 
added. Click the Add Lane button again to exit the editing mode. The Data Table will readjust accordingly, 
adding the lane and calculating results for the bands within the lane.

Delete Lane
This option allows lanes to be deleted. To delete a lane, select the Delete Lane button and place the mouse 
on the image. A cursor will display on the image. Place the cursor anywhere on the lane to be deleted, then 
click the mouse to delete the lane. Continue until all desired lanes are deleted. Click the Delete Lane but-
ton again to exit the editing mode. To delete lanes when not in editing mode, simply click on the lane and 
select the Delete key on the keyboard. The Data Table will readjust to remove the deleted lane data. 

Move Path
This feature allows for the horizontal manipulation of the center line in each of the found bands. To do this, 
click on the Move Path button. To move the path over a band, position the cursor over the band centroid, 
then click and drag to move the path. To move a lane path, position the cursor over an area in a lane without 
bands, then click and drag to move the lane path. To skew an entire lane path, click on the round end point of 
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the path at the top or bottom of the lane, then click and drag the lane to skew it to the desired position. Click 
the Move Path button again to exit the editing mode. The integrated area of each band will be updated in 
the Data Table as the curve is refigured to match the pixels surrounding the centroid mark.

Add Band
This option allows bands to be added. To add a band, select the Add Band button and place the mouse on 
the image. A plus sign cursor will display on the image. Place the cursor on the band of interest, then click the 
mouse to add the band. Continue until all new bands are added. Click the Add Band button again to exit 
the editing mode. The Data Table will readjust accordingly, and results for the new bands will be displayed. 

Delete Bands
This option allows bands to be deleted. To delete a band, select the Delete Band button and place the 
mouse on the image. A cursor will display on the image. Place the cursor on the band of interest, then click 
the mouse to delete it. Continue until all bands of interest are deleted. Click the Delete Band button again 
to exit the editing mode. To delete bands when not in editing mode, simply click on the band and select the 
Delete key on the keyboard. The Data Table will readjust accordingly, and results for the deleted bands will be 
removed.

Band Filter - Adjusting Peak Detection Parameters
The parameters in the Band Filter box on the Bands tab allow adjustment of the automatic peak finder 
parameters.

Figure 5-50: Band Filter Parameters

There are three attributes that determine whether or not the automatic peak finder recognizes a region of 
the graph as a peak: Minimum Area, Minimum Height and Minimum Width. To apply minimum peak 
find attributes to the analyzed image, select the appropriate checkbox. Either enter a value or click on the 
arrow(s) to adjust the setting. If a value is entered manually, hit the Enter key on the keyboard to apply the 
changes. If a minimum peak find attribute will not be used, deselect its checkbox. 

As each setting is adjusted, the automatic peak finder rescans the graph and defines the peaks based on the 
new settings. A peak is recognized only if it meets the criteria defined in the minimum peak attribute settings. 
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NOTE: Using the Minimum Width control setting is the quickest way to regulate the number of peaks 
detected by the automatic peak finder.

Figure 5-51: Minimum Width is 10

Figure 5-52: Minimum Width is 17

Display Options
These features allow the user to change the visual display of the lanes and bands on the analyzed image. To 
access the dialog box select the Display Options button from the Bands tab.

• The Lane Property box provides the following options: 

• Show Center Line: displays the vertical line which runs through the center of each of the bands. 

• Show Lane Boundary: displays the perimeter of each of the lanes found in the gel (selected by 
default).

• Show Profile Boundary: displays the profile path width in each of the lanes (selected by default).

• Names: the selected radio button will display the lane name by number (Numerical) or by letter 
(Character). 

• Under Band Representation, the Cross selection designates bands with a cross symbol. The Box selec-
tion will display a two-dimensional box around each of the bands. 

• Show Band Properties turns the band property display on/off. The Band Property value to be dis-
played is selected under Band Property.
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